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1. Plan your Teamcenter Visualization
installation
Deploying Teamcenter Lifecycle Visualization in a Teamcenter environment provides your entire
organization with the ability to view design data while also letting you explore and validate product
innovations and issues in a collaborative environment. Additionally, PLM XML support provides a
lightweight, extensible mechanism for sharing product data with other Siemens Digital Industries
Software products and supported third-party applications.

You can use Visualization in the following ways in the Base, Standard, Professional, and Mockup product
configurations:

• In the external standalone application viewer, which is a standalone visualization viewer outside of a
Teamcenter client

• In the web-based client interface provided by Active Workspace, which includes built-in dynamic
visualization capabilities for using dynamic 3D and 2D visualization functionality

• In the Lifecycle Viewer perspective of the rich client

Before you begin — Plan and install the client of your choice for visualizing components, performing
analysis, and saving your work to the Teamcenter database. You can choose from the following client
options.

Standalone Visualization —
Java-based desktop client outside of a Teamcenter client

Active Workspace —
Web-based client
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Rich Client —
Java-based desktop client within Teamcenter

Choose the components to install — 

Your choice of the Teamcenter client you determines the other components you need to install.

Where do I go from here?

 Business User • Create and work with sessions to save the
state of the viewer in Active Workspace.

• Capture the state of the 3D viewing window
as a snapshot in Active Workspace and Rich
Client.

1. Plan your Teamcenter Visualization installation
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• Create and manage sections in Active
Workspace and Rich Client.

 Administrator

How do I set up Teamcenter for visualizing
models either in Active Workspace or in the rich
client?

Choose the client and install the different
components required for visualizing models.
Then, perform any post-installation tasks.

How do I configure Teamcenter to visualize
models in the web client

Depending on your requirements, you can
change aspects of visualization to improve
security, display, logging, and performance.

How do I optimize Visualization Server system
performance in Active Workspace?

You can modify Visualization Pool Assigner
and Visualization Server Manager configuration
parameters that impact server scalability.

How do I configure Active Workspace to connect
with Lifecycle Visualization?

You can connect Active Workspace and Lifecycle
Visualization in one of two ways. You can use
the default option, the info browser hosted
in the Lifecycle Visualization desktop, or you
can use your external default browser through
Active Workspace Application Connect.

How do I monitor visualization components? You can monitor visualization components in
the Viewer Administration page on Active
Workspace or monitor the Active Workspace
Visualization Server system using a Java
Management Extensions (JMX) client.

How do I ensure that Lifecycle Visualization
works seamlessly in Teamcenter?

For Lifecycle Visualization to work seamlessly
in Teamcenter, you must have the appropriate
license. The licensing is required for the
Lifecycle Viewer and the Teamcenter embedded
viewer.

How do I configure Teamcenter to visualize
models in the rich client

Depending on your requirements, you can
change aspects of Teamcenter to ensure server
compatibility, embedded viewer compatibility,
and so on.

How do I configure the behavior of Lifecycle
Visualization datasets for the rich client?

To do this, set the Teamcenter Integration
preferences to specify the default behavior of
datasets in Lifecycle Visualization.
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2. Install Teamcenter Visualization
Installing Visualization with Teamcenter involves adding visualization capabilities to a Teamcenter client,
such as rich client or Active Workspace.

Prerequisites

Before you install Visualization, make sure you have finalized the Teamcenter client that you want to
use.

Lifecycle Viewer support for Teamcenter versions is consistent with Lifecycle Visualization support.
Download the Teamcenter Interoperability Matrix spreadsheet found on the Support White Papers
Certifications page on Support Center.

Procedure

1. Install Lifecycle Visualization using the standalone installer.

For more information about installing standalone Lifecycle Visualization, see Installation under
Teamcenter Lifecycle Visualization.

2. Install the Visualization Server components.

a. Visualization Server Manager

b. Visualization Server Pool Assigner

c. (Optional) Visualization Data Server

3. Perform the post-installation tasks for the Visualization Server.
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3. Connect to an existing 3D Clearance
database using Deployment Center
Add the 3D Clearance application to your existing Teamcenter environment and connect ClearanceDB for
Active Workspace using Deployment Center. You will connect the ClearanceDB to an existing clearance
database using the web service. This gives end users the ability to view Clearance results in Active
Workspace.

Note:

You do not need a proxy when using Active Workspace Clearance. The web service takes place as
the proxy.
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Procedure

1. Log on to Deployment Center and select the environment to which you want to add 3D Clearance.

2. Go to the Applications task. Click Add or Remove Selected Applications .

3. In the Available Applications panel, use the web browser search to find the 3D Clearance
application. Select the application, and then click Update Selected Applications.

Deployment Center automatically selects any additional dependent applications.

4. Go to the Components task.

3. Connect to an existing 3D Clearance database using Deployment Center
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5. In the Selected Components list, select the ClearanceDB Server Configuration component.

6. In the ClearanceDB Server Configuration panel, enter values for the following configuration
parameters:

Parameter Description
Database Host Host machine name on which the Clearance database is installed.
Port The port number used to connect to the Clearance database.
Service The Clearance database service name. The default service name is ORCL.
User The Clearance database user name. The default user name is CLOWNER.
Password The password for the Clearance database user.
Confirm Password Confirmation of the Clearance database user password.
Enable per-user
access to the
Clearance Database

Enables either specific users or all users to view and disposition Clearance
results in Active Workspace:

• To enable specific users, select the check box. Additionally, assign users
to a ClearanceDB role.

• To enable all users, clear the check box.

7. When you finish entering values for the ClearanceDB Server Configuration component, click Save
Component Settings.

8. In the Selected Components list, note any remaining components whose configuration status is
not 100%. Select each incomplete component, enter required parameters, and save component
settings until all components in the environment show a configuration status of 100%.

When all components are fully configured, the Deploy task is enabled.

9. Go to the Deploy task. Click Generate Install Scripts to generate deployment scripts you will use
to update affected machines.

When script generation is complete, note any special instructions in the Deploy Instructions panel.

10. Locate deployment scripts, copy each script to its target machine, and then run each script on its
target machine.

For more information about running deployment scripts, see Deployment Center ─ Usage.

Postrequisites

Configure the ClearanceDB for Active Workspace.
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4. Install 3D Clearance using Teamcenter
Environment Manager (TEM)
Add the 3D Clearance application to your existing Teamcenter environment to install ClearanceDB for
Active Workspace. You must install ClearanceDB for end users to be able to view Clearance results in
Active Workspace.

Prerequisites

This procedure assumes you have an existing Teamcenter environment with Active Workspace.

Procedure

1. Launch Teamcenter Environment Manager.

• Windows systems

In the Windows program list, click Teamcenter, and then right-click Environment Manager and
choose Run as administrator.

• Linux systems

Change to the TC_ROOT/install directory, and then run the tem.sh script.

2. In the Maintenance panel, choose Configuration Manager.

3. In the Configuration Maintenance panel, choose Perform maintenance on an existing
configuration.

4. In the Old Configuration panel, select the configuration to which you want to add Active
Workspace.

5. In the Feature Maintenance panel, select Add/Remove Features.

6. Proceed to the Features panel, and under Base Install→Active Workspace→Client, select the
following features:

• 3D Visualization

• 3D Clearance

7. Proceed through the remaining panels in TEM, entering any required parameters.

For more information about each panel, click the Help button.
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8. In the Confirmation panel, click Start to begin installation.

9. When the installation is complete, close TEM.

4. Install 3D Clearance using Teamcenter Environment Manager (TEM)
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5. Install XR Visualization
Install the XR Visualization application, which adds extended reality (XR) visualization to your
Teamcenter environment.

Prerequisites

Install a Teamcenter environment using Deployment Center.

Procedure

1. Log on to Deployment Center and select the environment to which you want to add XR
Visualization.

2. Go to the Applications tab. Click Add or Remove Selected Applications .

3. In the Available Applications panel, use the web browser search to find the XR Visualization
application. Select the application, and then click Update Selected Applications.

Deployment Center automatically selects additional dependent applications.

4. Go to the Components tab.

5. Configure the Visualization Server Manager component:

a. Go to the Components tab, and in the Selected Components list, select Visualization
Server Manager.

b. In the Visualization Server Manager panel, enter values for the following configuration
parameters:

Parameter Description
XR Service Endpoint Type the URL to the XR service endpoint.
XR ACC Endpoint Type the URL to the XR ACC endpoint.
DSS Service Endpoint Type the URL to the DSS service endpoint.

c. Under Gateway Settings > File transfer protocol, select whether to use secure protocol for
VSM communication with the Active Workspace Gateway. If you select https, the VSM uses
the HTTPS configuration specified in the HTTPS Config component.

The HTTPS Config component is configured during creation of the Teamcenter environment.

d. When you finish entering values for the Visualization Server Manager component, click Save
Component Settings.
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e. In the Selected Components list, note any remaining components whose configuration
status is not 100%. Select each incomplete component, enter required parameters, and save
component settings until all components in the environment show a configuration status of
100%.

When all components are fully configured, the Deploy tab is enabled.

6. Go to the Deploy tab. Click Generate Install Scripts to generate deployment scripts you will use to
update affected machines.

When script generation is complete, note any special instructions in the Deploy Instructions panel.

7. Locate deployment scripts, copy each script to its target machine, and then run each script on its
target machine.

For more information about running deployment scripts, see Deployment Center ─ Usage.

5. Install XR Visualization
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6. Installing the Visualization Server for
Active Workspace
Overview of the Visualization Server

The Visualization Server provides dynamic 3D and 2D visualization functionality for the Active
Workspace. If you do not use the 3D viewer or the 2D part feature of the universal viewer in the Active
Workspace, you need not install the Visualization Server.

The Visualization Server contains the following components.

Choosing client-side or server-side rendering

At a glance: client-side rendering versus server-side rendering

Client-side rendering (CSR) uses WebGL to leverage client-side graphics capabilities using the Active
Workspace browser. Server-side rendering (SSR) does not require WebGL and is suited to larger
structures. The following comparison may help you decide which option to use.

Conditions CSR SSR
Data size limit The data size limit is affected by browser

memory, transfer time tolerance, and WebGL
performance as the data size increases.

This option provides the highest
data size limit, because the server
has substantial CPU, RAM, and GPU
resources.
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Conditions CSR SSR
Using render acceleration can increase this
limit significantly.

Load speed All data is streamed to the client.

Browser caching for client-side rendering is
supported.

Best option for loading speed.

Data is localized to the render server.

User
experience
interaction

Best experience within the limits of WebGL
performance.

All drawing and interactions are local.

Rendering is unaffected by network traffic, so is
more responsive and less latency sensitive.

Good experience, especially with low
latencies.

Better-to-best experience when
working with significantly increased
data sizes.

Server cost per
user

Lower cost. No server-side graphics card is
required.

Offloading rendering to clients means the
system can support more users per server.
However, the triangles of the model must be
loaded onto the client machine before it can
render.

This option has a higher cost, but
it can be more cost effective than
putting a high-end graphics device
on every user's desk.

Device support Devices that support WebGL and an HTML5
web browser.

Devices that support an HTML5 web
browser. This option is necessary for
devices that do not support WebGL.

Reserve slots on SSR servers for SSR users unless all CSR capacity is consumed

To optimize resource utilization, the Visualization Server Pool Assigner directs SSR users to SSR-capable
servers, while diverting CSR users to servers that can support CSR users only. However, since SSR servers
can also support CSR users, when all CSR servers are busy and the SSR servers still have capacity, you can
use SSR servers to support CSR users. This provides flexibility within the enterprise while reserving SSR
servers for users who need that resource.

To adjust or disable this behavior, you can contact Siemens Digital Industries Software support.

Rendering 3D data

In Active Workspace, the 3D viewer is displayed within the universal viewer area of the Overview tab for
objects that have viewable attachments. The 3D viewer is also displayed in the 3D tab, where you can
explore 3D data (JT) associated with parts and assemblies. The render location setting applies to both
viewer locations.

Visualization Server is required for visualizing 3D data in Active Workspace with CSR. However, the
Visualization Server Manager can be installed on a server without a graphics card.

For better user experience and certain functionality to work, ensure the following:

6. Installing the Visualization Server for Active Workspace
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• The client machine for CSR must have a valid graphics card.

• You must enable WebGL on the browser.

• For SSR, even the server must have a valid graphics card.

Set default rendering method

To set the default rendering method for the 3D viewer and the universal viewer, set the value of the
AWV0ViewerRenderOption Teamcenter preference to either of the following:

• For client-side rendering (default option): Set the value to CSR.

• For server-side rendering: Set the value to SSR.

End users can change the rendering method on the Viewer Options panel in Active Workspace.

Additional settings for CSR

Ensure that you are not using integrated graphics, and perform the following steps to switch to your
graphics card:

1. Open the NVIDIA Control Panel.

2. Click 3D Settings→Manage 3D Settings.

3. Click the Program Settings tab.

4. From the list shown, select the program for which you want to choose a graphics card.

5. Select the preferred graphics processor from the list.

Alternatively, ensure that the GPU is used when running Google Chrome:

1. Open Windows settings (Windows key+I).

2. Search for graphics settings or GPU.

Should I use MMV?

Massive Model Visualization (MMV) is a visualization technology that uses Visibility Guided Rendering
(VGR) to increase performance and scalability when viewing extremely large 3D models, such as cars,
airplanes, and ships. Models of this size typically consist of a massive amount of geometry arranged in
a relatively compact space with a huge amount of internal geometry hidden behind the outer shell of
the product. It can take hours to display such models in their entirety, because every piece of geometry

Should I use MMV?
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in the model needs to be retrieved and processed, far exceeding the typical capability most hardware.
MMV technology resolves this problem by leveraging VGR techniques to load only those parts that are
required to render a given scene; parts that are not visible because they are occluded by other parts
in the foreground are not loaded. As a result, large 3D models become visible in a fraction of the time
previously required.

Note:

If a structure has more than 30,000 BOM lines, MMV is recommended. If a structure has more
than 120,000 BOM lines, MMV rendering is required for scalability and performance.

Visualization of MMV data in the Active Workspace requires an MMV license. If the necessary license is
not present, the full model loads as standard JT data.

A Visualization Data Server is required for implementing MMV but is otherwise optional.

To use the Visualization Data Server to compute Massive Model Visualization (MMV) spatial hierarchies
of structures, you must do the following actions:

1. Apply the MMV index structure flag to the product configurations that you want to view using
MMV.

2. Use the bomindex_admin utility to include the configurations in the list of structures to index.

The Visualization Data Server has a structure and JT pre-caching feature that can help improve
visualization performance for structures not indexed for MMV. To use this feature:

1. Apply the VDS indexing flag for product configurations that will be viewed frequently but are not
indexed for MMV.

2. Use the bomindex_admin utility to include the configurations in the list of structures to index.

Visualization Server Manager prerequisites

Operating systems

The Visualization Server Manager (VSM) supports both large model visualization (LMV) and massive
model visualization (MMV) on supported Microsoft Windows and Linux server platforms.

On a Linux machine without a GPU or without a supported level of OpenGL, client-side rendering is
supported, but server-side rendering is not supported and fails to load.

For supported OS versions, see the Hardware and Software Certifications knowledge base article on
Support Center.

6. Installing the Visualization Server for Active Workspace
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Server hardware and graphics cards

The following hardware is supported for VSM:

• For server-side rendering:

Server class hardware certified by NVIDIA to support NVIDIA RTX 6000, RTX 8000, T4, A10, A40, GRID
K1, K2, Tesla M60, or P40 graphics cards. Note that any server capable of supporting server-side
rendering also supports client-side rendering.

• For client-side rendering:

GPU hardware requirements for desktop Visualization applications (Lifecycle Visualization) are
sufficient for client-side rendering.

If no server-side rendering is needed, any web server class hardware is sufficient to support client-side
rendering (CSR).

The Visualization Server is required for visualizing 3D data in Active Workspace with client-side
rendering. However, to use client-side rendering, you must install the Visualization Server Pool
Assigner and VSM on a server without a graphics card.

Sizing of hardware should be appropriate to support intended data sizes and usage patterns. See VSM
hardware sizing for more info about hardware sizing.

Windows Server versions supported with the VSM support a maximum of 8 GPUs, with certain
exceptions. For example, on a Windows Server 2012 R2 machine with two NVIDIA GRID K1 cards, the
legacy VGA device makes the fourth GPU on one card unavailable for use.

Active Workspace supports virtualized server-side rendering for certain hardware and software
combinations.

NVIDIA usage requires NVIDIA virtual application licenses — one per concurrent user.

For information about server hardware compatible with supported NVIDIA GRID graphics cards, see
www.nvidia.com.

Virtualization

If you use only client-side rendering, the VSM can be virtualized.

If you use server-side rendering, the VSM must be installed on physical hardware, unless you follow a
supported virtualization combination.

Active Workspace visualization supports virtualization for certain combinations of:
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• Host OS and version

• Virtualization layer

• Guest OS and version

• NVIDIA GPU

For information about supported combinations, see the Graphics Card Certification Matrix in
the Hardware and Software Certifications knowledge base article on Support Center: https://
support.sw.siemens.com

For information about NVIDIA virtual GPU compatibility, see NVIDIA virtual GPU (vGPU) software
documentation at docs.nvidia.com.

VSM hardware sizing

Sizing of VSM hardware should allow for typical and maximum expected usage by considering the
following factors:

• Expected numbers of concurrent Active Workspace visualization users

• Expected product data sizes

• CPU, RAM, VRAM and GPU resources consumed by expected product data

In general, a high end server with:

• A maximum number of CPU cores with processing speeds of 3.0 GHz or faster

• A minimum of 64 GB of RAM

• A minimum of 256 GB of disc space

In addition, a VSM that will support server-side rendering requires an NVIDIA GRID graphics card.
For information about server hardware compatible with supported NVIDIA GRID graphics cards, see
www.nvidia.com.

For additional guidance in sizing of VSM hardware, contact your field services professionals.

Environment information

Make sure you know the following values. These are needed during installation of the VSM.

Visualization Server Pool Assigner host and port
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These are defined in Install the Visualization Server Pool Assigner.

Visualization Data Server host and port (if VDS is to be installed)

These are defined in Install the Visualization Data Server.

Host and port of FCC parents

These are defined during Teamcenter installation.

Linux machine configuration

Before you run the VSM on a Linux machine, perform the following steps:

1. Make sure the machine has the required RPM package managers.

2. Install the required fonts:

sudo yum install '*font*' --skip-broken

3. Make sure that Xserver is installed and running on DISPLAY :0. One way to verify this is to type the
following command to determine whether the X or Xorg process is running:

ps -ef | grep "/usr/.*/X.*:0" | grep -v grep

The command returns output similar to the following:

>ps -ef | grep "/usr/.*/X.*:0" | grep -v grep 
root      9533     1  0  2023 ?        00:00:00 sudo /usr/bin/Xorg :0
     -background none -verbose -auth /run/user/471/gdm/Xauthority 
     -seat seatO -listen tcp vt7
root      9534  9533  0  2023 tty7     00:25:42 /usr/bin/Xorg :0
     -background none -verbose -auth /run/user/471/gdm/Xauthority 
     -seat seatO -listen tcp vt7

The exact output from the grep command may vary depending on the configuration of your Linux
environment, but the output must contain /user/bin/Xorg :0 or/user/bin/X :0 where shown above.
This indicates that the Xserver is running on DISPLAY :0 and that your environment is supported.

If you reboot the system, you must restart Xserver.

Note:

The Xserver allows graphical user interfaces on a Linux system. When you install Linux, if you
installed a minimal text-only environment, you must install Xserver according to your Linux
Xserver installation and setup guide.
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If you installed a graphical environment, Xserver and Xorg should already be installed. The
Xserver manages the display hardware to provide a graphical interface. To use X applications,
install the Xorg X11 apps package.

For information about configuring Xserver, see your Linux system configuration
documentation.

4. After you verify that Xserver is running on DISPLAY :0, configure Xserver for offscreen and headless
operation for use by the visualization server processes.

• Linux machine with no GPU:

After you verify that Xserver is running on DISPLAY :0, run the following commands:

setenv DISPLAY :0
xhost +

You must run these commands after a reboot.

The commands return output similar to the following:

>setenv DISPLAY :0
>xhost +
access control disabled, clients can connect from any host

• Linux machine with GPU:

Set up the NVIDIA GPU on the Linux machine by running the setup_xserver.sh script provided in
the Visualization Server Manager installation.

a. Change to the TC_ROOT/vispoolmanager/jetty directory.

b. Type the following command:

setup_xserver.sh default

The default parameter specifies to use the graphics card and bus id discovered by the script.
If you do not specify this parameter, the script prompts you to confirm the card and bus id, and
provides the opportunity to change these values if you want.

Install the Visualization Server Manager

Install the Visualization Server Manager using Deployment Center

1. Log on to Deployment Center.
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2. In the Environments list, select the environment to which you want to add the Visualization Server
Manager (VSM), or click Add Environment  to create a new environment.

3. In the Software tab, make sure the Teamcenter 2412 software kit is included in your environment.

4. Proceed to the Applications tab and then click Add or Remove Selected Applications .

5. In the Available Applications list, select Visualization Extension.

This selection adds the Visualization Server Manager and Visualization Pool Assigner
components to the environment.

6. Select 3D Visualization or Active workspace Visualization 2D Viewer if you wish to add the
Viewer Administration application, which provides an interface for monitoring Visualization
Server components in Active Workspace.

7. Click Update Selected Applications.

8. Proceed to the Components tab.

9. In the Selected Components list, select Visualization Server Manager.

10. Enter configuration parameters for the VSM:

a. If your environment type, which is specified in the Options tab, is Distributed, type the values
for the Machine Name and OS for the machine deploying the VSM.

Also, in the Teamcenter Installation Path box, type the path for the location where you will
install Teamcenter software on the VSM machine.

Note:

If your environment type is Single Box, then the Machine Name, OS, and Teamcenter
Installation Path boxes are read-only and cannot be changed.

b. Under Gateway Settings > File transfer protocol, select whether to use secure protocol for
VSM communication with the Active Workspace Gateway. If you select https, the VSM uses
the HTTPS configuration specified in the HTTPS Config component.

The HTTPS Config component is configured during creation of the Teamcenter environment.

c. If you want to change other default configuration parameters for the VSM, click Show all
parameters  and change values as necessary.

d. Click Save Component Settings.

Install the Visualization Server Manager
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11. In the Components tab, note any components which do not have a configuration status of 100%.
Enter or update configuration parameters until all components show a configuration status of
100%.

12. Proceed to the Deploy tab. Click Generate Install Scripts to generate deployment scripts to update
affected machines.

When the script generation is complete, note any special instructions in the Deploy Instructions
panel.

13. Locate the deployment scripts, copy each script to its target machine, and run each script on its
target machine.

For more information about running deployment scripts, see Deployment Center ─ Usage.

Install the Visualization Server Manager using TEM

You can install the Visualization Server Manager in a new Teamcenter configuration or in an existing
Teamcenter configuration.

If you are adding the Visualization Server Manager to an existing configuration, launch the installed TEM
in maintenance mode and skip to step 8 below.

Otherwise, if you are installing the Visualization Server Manager on a host with no existing Teamcenter
environment, proceed with the following steps:

1. Ensure you have access to the Teamcenter 2412 software kit.

2. Launch TEM from the Teamcenter 2412 software kit.

On Windows systems, launch TEM with administrator privileges by using right-click→Run as
administrator.

3. In the Welcome to Teamcenter panel, select Teamcenter.

4. In the Install / Upgrade Options panel, click Install.

5. In the Media Locations panel, you can optionally specify the locations of any Teamcenter update
software kits you want to apply to your configuration. Otherwise, proceed to the next step.

6. In the Configuration panel, enter values for ID and Description.

7. In the Solutions panel, make no selections.

8. Proceed to the Features panel, and under Base Install→Active Workspace→Visualization Server,
select the Visualization Server Manager feature.
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In the Installation Directory box, enter the location in which to install the Visualization Server
Manager.

9. In the File Client Cache (FCC) panel, set the FMS_HOME environment variable.

10. In the FCC Parents panel, define the list of FSC parents to which the Visualization Server Manager
connects.

You must provide the protocol, host, and port of the FSC parent. To add rows to the table, click
Add.

Note:

If you are using a Visualization Data Server, the Visualization Data Server and the
Visualization Server Manager should use the same FSC.

11. In the Configuration section of the Visualization Server Manager panel, provide values for the
Visualization Server Manager.

Local Host
Alias

Specifies the alias for the local Visualization Server Manager.

Server Host Specifies the host where the Visualization Server Manager is running. This must
be the local machine name and must be resolvable by the Visualization Pool
Assigner machine (the machine running the Active Workspace Gateway). Do not
use localhost or 127.0.0.1.

Server Port Specifies the port on which the Visualization Server is listening.

Max Servers
in Sub-Pool

Specifies the maximum number of Visualization Server processes allowed to run
in this pool for a single-host configuration or in this subpool for a multihost
configuration.

For example, on Windows machines, the default value is 30. On Linux machines,
the default value is 200.

Min Warm
Servers

Specifies the minimum number of Visualization Server processes in this pool that
are started but not assigned.

Note:

If necessary to maintain the minimum number of warm servers while not
exceeding the maximum number of server processes, the server manager
times out the servers in use.

12. If you use a Visualization Data Server, provide the values for this server in the Visualization Data
Server Configuration section of the Visualization Server Manager panel.
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Add
Visualization
Data Server

Select this if you are using a Visualization Data Server.

Host Type the name of the host on which the Visualization Data Server is installed.

Port Type the port value used by the Visualization Data Server.

A Visualization Data Server improves performance by caching product structure and JT parts files.

13. In the Visualization Server Manager Settings panel, define the settings for how the Visualization
Server Manager communicates with the pool assigners.

14. In the Operating System User panel, type the user’s password.

Override
local node
settings

Select this option to override the host name and the port value. Enter the Host
and Vis Assigner Port values of the local machine. In the Gateway Connection
Port box, enter the port used by the Active Workspace Gateway.

Visualization
Server Pool
Assigners

Lists the pool assigners that this Visualization Server Manager uses.

• Assigner Host

Host name of the machine where the Visualization Server Pool Assigner runs.

• Assigner Port

Port value of the pool assigner.

15. In the Confirmation panel, click Start.

16. When the installation is complete, close TEM.

Visualization Server Pool Assigner prerequisites

Software

The Visualization Server Pool Assigner requires the following software:

• A supported Microsoft Windows Server operating system or Linux operating system on the
Visualization Server Manager host.

For supported versions, see the Hardware and Software Certifications knowledge base article on
Support Center.
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• The Visualization Extension Server Extensions feature on the corporate server and on any server that
has Teamcenter Foundation installed.

Environment information

Make sure you know the following values. These are needed during installation of the Visualization
Server Manager.

Visualization Server Pool Assigner host and port

Visualization
Data Server
host and
port (if VDS
is to be
installed)

These are defined in Install the Visualization Data Server.

Host and
port of FCC
parents

These are defined during Teamcenter installation.

Install the Visualization Server Pool Assigner

Install the Visualization Server Pool Assigner using Deployment Center

1. Log on to Deployment Center.

2. In the Environments list, select the environment to which you want to add the Visualization Server
Pool Assigner (VPA), or click Add Environment to create a new environment.

3. In the Software tab, make sure the Teamcenter 2412 software kit is included in your environment.

4. Proceed to the Applications tab and then click Add or Remove Selected Applications.

5. In the Available Applications list, select Visualization Extension, and then click Update Selected
Applications.

This adds the Visualization Server Manager and Visualization Pool Assigner components to the
environment.

6. Proceed to the Components tab.

7. In the Selected Components list, select Visualization Pool Assigner.

8. Enter the configuration parameters for the Visualization Pool Assigner (VPA):

Install the Visualization Server Pool Assigner
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a. If your environment type, which is specified in the Options tab, is Distributed, type values for
the Machine Name and OS for the machine on which you deploy the VPA.

Also, in the Teamcenter Installation Path box, type the path in which to install Teamcenter
software on the VPA machine.

Note:

If your environment type is Single Box, the Machine Name, OS, and Teamcenter
Installation Path boxes are read-only and cannot be changed.

b. Enter the following configuration parameters for the VPA:

Value Description
File transfer protocol Specifies whether to use secure protocol for VPA communication

with the Active Workspace Gateway. If you select https, the
VPA uses the HTTPS configuration specified in the HTTPS Config
component.

The HTTPS Config component is configured during creation of the
Teamcenter environment.

Vis Assigner Port Specifies the port used by the local Visualization Server Pool
Assigner.

Gateway Connection
Port

Specifies the port through which the Active Workspace Gateway
connects to the Visualization Server Pool Assigner. The default
value is 8089.

Gateway Vis Assigner
URL

Specifies the URL through which the Active Workspace Gateway
accesses the VPA. This value is automatically based on the
Machine Name and Gateway Connection Port values. It is read-
only and cannot be directly changed.

c. If you want to change the default configuration parameters for the VSM, click Show all
parameters  and change values as necessary.

d. Click Save Component Settings.

9. In the Components tab, note components whose configuration status is not 100%. Enter or update
configuration parameters until all components show a configuration status of 100%.

10. Proceed to the Deploy tab. Click Generate Install Scripts to generate deployment scripts to update
affected machines.

When the script generation is complete, note any special instructions in the Deploy Instructions
panel.
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11. Locate the deployment scripts, copy each script to its target machine, and run each script on its
target machine.

For more information about running deployment scripts, see Deployment Center ─ Usage.

Install the Visualization Server Pool Assigner using TEM

You can install the Visualization Server Pool Assigner in a new Teamcenter configuration or in an existing
Teamcenter configuration.

If you are adding the Visualization Server Pool Assigner to an existing configuration, launch the installed
TEM in maintenance mode and skip to step 8 below.

Otherwise, if you are installing the Visualization Server Pool Assigner on a host with no existing
Teamcenter environment, proceed to step 1.

1. Ensure you have access to the Teamcenter 2412 software kit.

2. Launch TEM from the Teamcenter 2412 software kit.

On Windows systems, launch TEM with administrator privileges by using right-click→Run as
administrator.

3. In the Welcome to Teamcenter panel, select Teamcenter.

4. In the Install / Upgrade Options panel, click Install.

5. In the Media Locations panel, you can optionally specify the locations of any Teamcenter update
software kits you want to apply to your configuration. Otherwise, proceed to the next step.

6. In the Configuration panel, enter values for ID and Description.

7. In the Solutions panel, make no selections.

8. Proceed to the Features panel, and under Base Install→Active Workspace→Visualization Server,
select the Visualization Server Pool Assigner feature.

In the Installation Directory box, enter the location in which to install the Visualization Server
Manager.

9. In the Visualization Server Pool Assigner Settings panel, enter settings to configure the
Visualization Server Pool Assigner:
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Value Description
Host Specifies the host on which this Visualization Server Pool Assigner runs.

This is the host on which this Visualization Server Pool Assigner is
deployed. You may type the host name or the IP address of the host.

Vis Assigner Port Specifies the port used by the local Visualization Server Pool Assigner.
Gateway Connection
Port

Specifies the port through which the Active Workspace Gateway
connects to the Visualization Server Pool Assigner. The default value is
3000.

Add pool assigner Specifies whether additional Visualization Server Pool Assigners are used.
Select the Add pool assigner check box to add pool assigners.

Peer Assigners The Peer Assigners table lists other Visualization Server Pool Assigners
known to the local Visualization Server Pool Assigners.

Assigner Host Specifies the host on which a peer Visualization Server Pool Assigner is
deployed. This value can be the host name or IP address.

Assigner Port Specifies the port number used by the peer Visualization Server Pool
Assigner.

Server Side 4-tier URL Specifies an alternate four-tier URL for the viewer to connect to
Teamcenter. The Visualization Server uses this in case the primary four-
tier URL is blocked by a firewall, or if a more direct route is needed for
performance.

10. In the Confirmation panel, click Start.

11. When the installation is complete, close TEM.

Visualization Data Server prerequisites

Software

The Visualization Data Server requires the following software:

• A supported Microsoft Windows Server operating system or Linux operating system on the
Visualization Server Manager host.

For supported versions, see the Hardware and Software Certifications knowledge base article on
Support Center.

• The Visualization Extension Server Extensions feature on the corporate server and on any server that
has Teamcenter Foundation installed.

• A Visualization Server Manager installed on the Visualization Data Server host.

• An FMS client cache (FCC) component on the Visualization Data server host.
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• Structure indexing configured on the Visualization Data server host.

The Visualization Data Server uses the structure indexing infrastructure of Active Workspace to keep
cached product structure up-to-date.

Hardware

• Graphics card: No requirements.

• Network: You must deploy the Visualization Data Server on a high speed LAN near the Visualization
Server Manager.

• Memory: The Visualization Data Server host should have a minimum of 16 GB of RAM, but may
require more.

Note:

How to determine memory needed:

The amount of RAM needed depends on the number of structures to be indexed and their size.

A rough rule of thumb is to count the number of lines in the unconfigured structure to be indexed
and allow at least 2000 bytes per line. For example, if there are 1 million lines in the unconfigured
product index, then 1 million * 2000 = 2 GB of RAM.

If you are not sure of the size of the structures, Siemens Digital Industries Software recommends
that you allow approximately 4 GB of RAM for each structure you are planning to cache in
the Visualization Data Server. For example, if 4 structures are to be indexed, 16 GB of RAM is
recommended.

Environment information

You need to know the following values to install the Visualization Data Server:

• FCC parents

• Teamcenter web tier URL

• Host name and port for the Visualization Data Server

Recommendations

Siemens Digital Industries Software recommends that you install the Visualization Data Server on a
machine with the following:

• Multiple processors

Visualization Data Server prerequisites
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The Visualization Data Server is a multithreaded server program and is thus resource intensive;
multiple processors are utilized if they are available. Standard server class machine hardware is
sufficient.

• FSC cache or FSC volume

If you deploy the Visualization Data Server remote (on a WAN) from the FSC volume, you should
deploy an FSC cache on a LAN near or on the Visualization Data Server host machine.

• Visualization Server Manager

For maximum performance, the Visualization Data server should be installed on the same machine as
the Visualization Server Manager and should use the same cache.

A single Visualization Data Server can support one or more Visualization Server Managers.

Install the Visualization Data Server

Install the Visualization Data Server using Deployment Center

1. Log on to Deployment Center.

2. In the Environments list, select the environment to which you want to add the Visualization Data
Server (VDS), or click Add Environment to create a new environment.

3. In the Software tab, make sure the Teamcenter 2412 software kit is included in your environment.

4. Proceed to the Applications tab, and then click Add or Remove Selected Applications.

5. In the Available Applications list, select Visualization Extension, and then click Update Selected
Applications.

6. Proceed to the Components tab.

7. In the Selected Components list, select Visualization Data Server.

8. Enter configuration parameters for the VDS:

a. If your environment type, which is specified in the Options tab, is Distributed, then type the
values for the Machine Name and OS for the machine on which you deploy the VDS.

Also, in the Teamcenter Installation Path box, type the path in which to install Teamcenter
software on the VDS machine.
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Note:

If your environment type is Single Box, then the Machine Name, OS, and Teamcenter
Installation Path boxes are read-only and cannot be changed.

b. If you want to change the default configuration parameters for the VDS, click Show all
parameters  and change the values as necessary.

c. Click Save Component Settings.

9. In the Components tab, note components whose configuration status is not 100%. Enter or update
configuration parameters until all components show a configuration status of 100%.

10. Proceed to the Deploy tab. Click Generate Install Scripts to generate deployment scripts to update
affected machines.

When script generation is complete, note any special instructions in the Deploy Instructions panel.

11. Locate deployment scripts, copy each script to its target machine, and run each script on its target
machine.

For more information about running deployment scripts, see Deployment Center ─ Usage.

Install the Visualization Data Server using TEM

You can install the Visualization Data Server (VDS) in a new or an existing Teamcenter configuration.
Siemens Digital Industries Software recommends that you install the Visualization Data Server on a
machine that does not have a Teamcenter corporate server.

If you are adding the Visualization Data Server to an existing configuration, launch the installed TEM in
maintenance mode and skip to step 8 below.

Otherwise, if you are installing the Visualization Data Server on a host with no existing Teamcenter
environment, proceed to step 1 below.

1. Ensure you have access to the Teamcenter 2412 software kit.

2. Launch TEM from the Teamcenter 2412 software kit.

3. In the Welcome to Teamcenter panel, select Teamcenter.

4. In the Install / Upgrade Options panel, click Install.

5. In the Media Locations panel, you can optionally specify the locations of any Teamcenter update
software kits you want to apply to your configuration. Otherwise, proceed to the next step.
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6. In the Configuration panel, enter values for ID and Description.

7. In the Solutions panel, make no selections.

8. In the Features panel, select the Visualization Data Server feature:

Base Install→Active Workspace→Visualization Server→Visualization Data Server

In the Installation Directory box, enter the location in which to install the Visualization Data
Server.

9. In the File Client Cache (FCC) panel, set the FMS_HOME environment variable. The FCC must be
installed on the same machine as the Validation Data Server.

10. In the FCC Parents panel, define the list of FSC parents to which the Visualization Data Server
connects.

You must provide the protocol, host, and port of the FSC parent. To add rows to the table, click
Add.

Note:

To improve performance, the Visualization Data Server and the Visualization Server Manager
should use the same FSC.

11. In the Teamcenter Administrative User panel, enter the user's password.

12. In the Visualization Data Server Configuration panel, enter the required values:

• Server Port

This is the port number on which the Visualization Data Server listens.

• Teamcenter 4-tier URL

This is the URL of the Teamcenter web tier application. The format is:

http://host:port/tc-web-app

host is the machine running the web application server on which the Teamcenter web
application is deployed.

port is the port value used by the web application server.

tc-web-app is the name of the Teamcenter web application. The default is tc.
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13. In the Confirmation panel, click Start.

14. When the installation is complete, click Close.

Troubleshoot a new installation of Visualization

Intent

The following Teamcenter lifecycle visualization troubleshooting diagnostic sequence is:

• For new installations where visualization is non-functional.

• Tailored for clean systems that have never had a previous installation of Teamcenter lifecycle
visualization.

• Intended for use when the Visualization Pool Assigner is deployed on a Java server on Windows.

Usage notes

• Document all changes made during this process so that all unnecessary changes can be reverted once
the system works again.

• If a problem is identified and fixed during the diagnostic sequence listed here, but visualization still
does not work, return to the beginning of the diagnostic sequence.

Sequence

Use the following steps when troubleshooting a new installation of Teamcenter lifecycle visualization.

1. Verify that the servers are installed on computers that are running supported operating systems.
For example, Windows 7 Professional is unsupported.

2. Verify that the Visualization Server Manager is launched using the run_visservermgr.cmd script.

Caution:

Do not run the Visualization Server Manager as a Windows service, because doing so
significantly reduces stability and performance.

3. Verify that the Visualization Pool Assigner is launched using the run_visassigner.cmd script.
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Caution:

Do not run the Visualization Server Manager as a Windows service, because doing so
significantly reduces stability and performance.

4. If the Visualization Data Server is installed and running, terminate the Visualization Data Server. It
is not required for loading small to medium sized models.

5. Turn off all firewalls. If this is not possible, verify that all ports and port ranges specified in
Deployment Center or TEM have been opened through firewalls.

6. Restart the visualization system. The following sequence yields the cleanest startup:

a. Terminate the Visualization Server Manager.

b. Terminate the Visualization Pool Assigner.

c. Start the Visualization Pool Assigner.

d. Start the Visualization Server Manager.

7. Attempt to view 3D content in Active Workspace. A failure is expected.

8. Does the 3D window waiting cursor (rotating circle) show for a long time and does the 3D model
fail to appear?

If your
answer
is Action to take
Yes Log off and log on as the admin user. Navigate to Viewer Administration and verify that

at least one Visualization Pool Assigner and one Visualization Server Manager is listed.

If no Visualization Pool Assigner and Visualization Server Manager are listed, do the
following:

a. Navigate to the Gateway installation.

b. Verify that Gateway forwarding is correctly pointing to the deployed Visualization
Pool Assigner by verifying that the following entry is correct in the config.json file.

 "vis": {

 "path": "/VisProxyServlet",
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If your
answer
is Action to take

 "target": "http://
<VisAssignerHostname>:<VisAssignerHostPort>>
/VisProxyServlet"

}

Here, VisAssignerHostname and VisAssignerHostPort are the host and port
where the Visualization Pool Assigner was configured.

No Continue.

9. Does the following message appear in the Visualization Server Manager console within two
minutes of startup? Vis Server Manager is ready

If your
answer is Action to take
Yes Continue.
No • Does a JVM_Bind error appear in the Visualization Pool Assigner or Visualization

Server Manager console or log?

• Yes: The server’s Socket Cache port is already in use by another process. Either
use TEM to alter the port, or terminate the process that is presently using the
port. Then, restart the visualization system.

• No: Continue.

• Does the following error appear in the Visualization Server Manager console?
Trouble connecting to cold visualization server on port <PORT> with PID <PID> due
to ‘The VisView's reported system CPU usage (-1.0) is less than 0’. Retrying.

• Yes:

a. Verify that the Visualization Server Manager is installed on a computer that
is running a supported operating system.

b. On the machine hosting the Visualization Server Manager, run the
following Windows commands:

cd C:\Windows\SysWOW64

lodctr /r

winmgmt /resyncperf
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If your
answer is Action to take

c. Restart the Visualization Server Manager.

d. If the problem persists, contact the vendor.

• No: Continue.

• Does the following error appear in the Visualization Server Manager console? Error
reading 'begin' notification

• Yes: You are likely pointing your Visualization Server Manager at an incorrect
server or port. For example, you may be pointing it at the Visualization Pool
Assigner’s HTTP server instead of the Visualization Pool Assigner’s Socket Cache
server. If not, contact the vendor.

• No: Continue.

• Verify that the appropriate Microsoft Visual Studio Redistributables are installed.
They are typically installed automatically.

a. Launch VisServerFV\Products\FoundationViewer\visview.exe.

b. Does VisView appear?

• Yes: Continue.

• No: Does an error message appear that complains of a missing MFC DLL?

■ Yes: Download and install the appropriate redistributables.

■ No: A different warning or error message is observed. Continue.

• Is the Visualization Server Manager repeatedly reporting an error beginning with
Could not connect to VisPoolAssigner?

• Yes:

■ The Visualization Pool Assigner is running a server called the Socket Cache,
but the Visualization Server Manager is reporting that it cannot connect
to that server. Verify that the VisPoolProxy.peerNodes property in the
Visualization Server Manager’s jetty/jettyservice.properties file will allow the
Visualization Server Manager to contact the Visualization Pool Assigner’s
Socket Cache server.

■ If the problem persists, contact the vendor.

6. Installing the Visualization Server for Active Workspace
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If your
answer is Action to take

• No: Continue.

• Purge the registry areas for VisView:

a. Terminate the Visualization Server Manager.

b. Run Windows' Registry Editor, regedit.exe.

c. Using the Registry Editor, delete the following folders in the registry:

HKEY_CURRENT_USER/Software/Siemens/AW/
<<AW_RELEASE_VERSION>
HKEY_CURRENT_USER/Software/Siemens/AW_Retained/
<<AW_RELEASE_VERSION

d. Restart Visualization Server Manager and retest.

e. Continue.

• Contact the vendor.

10. Does the following error message appear in Active Workspace when trying to view 3D content? The
visualization servers are busy.

If your
answer is Action to take
Yes • Does the following error message appear in the Visualization Pool Assigner console?

All Pool Managers are full

• Yes:

a. Open the Visualization Server Manager's jetty/jettyservice.properties file and
note the value of VisPoolProxy.hostName.

b. From the Visualization Pool Assigner computer, open a command prompt
and run the command
ping <VisPoolProxy.hostName>
where <VisPoolProxy.hostName> is the value found in the jetty/
jettyservice.properties file.

c. Was a reply observed?

■ Yes: Continue.

Troubleshoot a new installation of Visualization
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If your
answer is Action to take

■ No: The Visualization Pool Assigner initiates communications with the
Visualization Server Manager using the VisPoolProxy.hostName and
VisPoolProxy.poolUrl values found in the jetty/jettyservice.properties file.
If the Visualization Pool Assigner cannot reach the Visualization Server
Manager using these values, then the system will not work.

d. If the problem persists, contact the vendor.

• No: Contact the vendor.
No Continue.

11. Is a new VisView process started when you attempt to load a model into Active Workspace?

If your
answer is Action to take
Yes Did the new process terminate a few seconds after starting?

• Yes: Contact the vendor.

• No: Continue.
No • Ensure that the VisPoolProxy.peerNodes in the jetty/jettyservice.properties file

is pointing at the correct Visualization Pool Assigner.

• If the problem persists, contact the vendor.

12. Configure the Visualization Server Manager to be in debug mode.

a. Create a backup of the jetty/jettyservice.properties file.

b. Open the jetty/jettyservice.properties file and change the following parameters:

• Set VisPoolProxy.warmServers=1

• Set VisPoolProxy.maxServers=1.

Setting this parameter to one prevents more than one VisView process from starting.

• Enable VisPoolProxy.envset.TCVIS_DA_DEBUG_LOG=True

• Enable VisPoolProxy.envset.TCVIS_LOGGING_LEVEL=DEBUG

c. Shut down Visualization Server Manager.

6. Installing the Visualization Server for Active Workspace
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d. Delete the contents of the jetty/TEMP directory.

e. Start Visualization Server Manager.

f. You are now in debug mode. Continue.

13. Configure Visualization Server Manager to operate with a virtual network card.

Open the jetty/jettyservice.properties file and change the following parameter:

Set VisPoolProxy.envset.TCVIS_CUSTOM_SYSTEM_NETWORK_BANDWIDTH=1000

This parameter sets the custom bandwidth in MBps for an instance or for the system. If you have a
Active Workspace installation and the Visualization Server that uses a virtual network card does not
start, enable this setting to start the Visualization Server.

14. Check for FCC problems.

a. Configure the Visualization Server Manager to be in debug mode. See this step.

b. Stop the Visualization Server Manager.

c. Verify that your FMS_HOME environment variable specifies the FCC installation area.

d. Purge FCC temporary files:

A. Run the following commands:

%FMS_HOME%/startfcc.bat

%FMS_HOME%/bin/fccstat –purge

%FMS_HOME%/bin/fccstat –kill

B. Delete the following:

• C:\Users\%USERNAME%\FCCcache*

• C:\Users\%USERNAME%\Teamcenter\SOA

• C:\Users\%USERNAME%\vendor\logs

• C:\Users\%USERNAME%\fcc.*

• VisDataServer/Program/scratch/*.

Troubleshoot a new installation of Visualization
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C. Start FCC manually using the %FMS_HOME%/startfcc.bat command and verify that
there are no errors.

e. Clear the contents of the jetty/TEMP area of the Visualization Server Manager.

f. Restart the visualization system.

g. Attempt to view 3D content in Active Workspace.

h. Examine the jetty/TEMP/VisProd*/tcvis_da_dbglog*.txt and address any error messages.

i. Open the jetty/TEMP/Visview<PID>.log file.

j. Does the log file contain any of these messages?

“ERROR: MkGetFileByFMSTicket”

“ERROR: MkCreateMoniker”

"ERROR: OpenDocumentByMoniker”

If your
answer is Action to take
Yes A. Open your FCC’s fcc.xml file and verify that it is pointing at correct

locations and that it is it free of typos.

B. If your FCC’s fcc.xml parentfsc is using HTTPS, verify the involved
certificates.

C. Review the FCC console for errors.

D. Review the jetty/TEMP/VisProd<PID>/*/tcvis_da_debug*.txt file for errors.

E. If the problem persists, contact the vendor.
No Continue.

15. Verify that the Visualization Server Manager has access to graphics hardware.

a. See the Configure the Visualization Server Manager to be in debug mode section earlier in
this procedure.

b. Open the jetty/TEMP/Visview<PID>.log file.

c. Does the log file contain the following message? System Supports OpenGL Version

6. Installing the Visualization Server for Active Workspace
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If your answer
is Action to take
Yes Is the value of System Supports OpenGL Version 1.2 or greater?

• Yes: Continue.

• No: Are you using supported graphics hardware?

• Yes:

A. Verify that your NVIDIA graphics driver is version 340.66 or later.

B. Verify that the computer is recognizing the graphics card.

C. If the problem persists, contact the vendor.

• No: No solution.
No Contact the vendor.

16. Contact the vendor.
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7. Post-installation tasks for setting up the
Visualization Server
Start the Visualization Server components

Once you install all the required and optional Visualization Server components, you must start them
individually in the following order.

Start Visualization Server Manager

Start Visualization Server Manager on Linux

To start the Visualization Server Manager (VSM) on a Linux machine, type the following command:

TC_ROOT/vispoolmanager/run_servermgr.sh

Optional: Start VSM as a Linux daemon

Alternatively, you can start Visualization Server Manager as a daemon by running the installservice.sh
command for each jetty server with admin permissions:

installservice.shunique-service-name port user 

If you do not specify parameters, the script will run in interactive mode and prompt you for the
information.

For example, from the TC_ROOT/vispoolmanager/jetty directory, type:

sudo ./installservice.sh MyUniquePoolManager1 8090 MyUser

Uninstalling the Linux daemon:

To uninstall the VSM daemon, run the uninstallservice.sh command for each jetty server with admin
permissions:
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uninstallservice.sh service-name

For example, from the TC_ROOT/vispoolmanager/jetty directory, type:

sudo ./uninstallservice.sh MyUniquePoolManager1

If you do not know the name of the service, search the TC_ROOT/vispoolmanager/jetty/ directory or
the /etc/systemd/system directory for a file named service-name.service. The service-name is the unique
service name you provided to the installservice.sh command.

Start the Visualization Server Manager on Windows

1. Make sure the FMS_HOME environment variable is set as a system environment variable and not
a user variable. Visualization Server Manager runs as a service only if FMS_HOME is a system
environment variable.

2. Run the following file:

TC_ROOT\vispoolmanager\run_visservermgr.cmd

Note:

If Visualization Server Pool Assigner (VPA) is not running, Visualization Server Manager
displays console messages until it finds the VPA. To avoid this, start Visualization Server
Pool Assigner before you start Visualization Server Manager.

When running run_visservermgr.cmd, you can use Windows remote desktop connection to sign on to
the machine on which Visualization Server Manager is installed if you have an NVIDIA card with a driver
version of 340.66 or later. Other remote access products, such as VNC, can also be used.

After running run_visservermgr.cmd, you can lock the machine, but you must remain logged on. If you
sign out, Visualization Server Manager is shut down.

Visualization Server Manager requires access to the graphics card. Therefore, it cannot run as a Windows
service in server-side rendering mode. However, you can start Visualization Server Manager as a
Windows service when you use client-side rendering exclusively.

Optional: Configure automatic logon and restart on Windows

You can configure Windows to automatically log on and restart Visualization Server Manager in the
event of a system reboot.

7. Post-installation tasks for setting up the Visualization Server

7-2  Visualization ─ Deployment and Administration, Teamcenter 2412
© 2025 Siemens



Caution:

Enabling automatic logon bypasses security. When Windows is configured to automatically log
on, anyone with physical access to the machine can restart it and gain entry to the system. Use
automatic logon only if the system is in a secure environment.

1. Open the Windows User Accounts dialog box:

a. Press the Windows key+R to display the Run dialog box.

b. In Open, type netplwiz, and then click OK.

2. In the User Accounts dialog box, select a user account from the list.

3. Clear the Users must enter a user name and password to use this computer check box.

4. Click Apply.

The Automatically sign in dialog box appears.

5. In the Password and Confirm Password boxes, type the user's password.

6. Click OK.

The specified user is automatically logged on when Windows starts.

7. Create a script or batch file to launch the Visualization Server Manager. Include the following
command to lock the workstation:

rundll32.exe user32.dll LockWorkStation

8. Create a new task with Windows Task Scheduler to run the script or batch file at log on.

Optional: Start Visualization Server Manager as a Windows service

You can start Visualization Server Manager as a Windows service only when you are exclusively using
client-side rendering. Windows services cannot access the graphics card, so this is not a suitable
deployment for server-side rendering.

1. To install Visualization Server Manager as a Windows service, run the installservice.bat command:

installservice.bat "%JAVA_HOME%" "VSM-dir" pool-IDport

Start Visualization Server Manager
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Replace VSM-dir with the path to the Visualization Server Manager’s jetty directory. Replace pool-
ID and port with the ID and port for the VisPoolManager service. The port must match the
VisPoolProxy.poolUrl port in the jettyservice.properties file.

For example:

installservice.bat "%JAVA_HOME%" "%TC_ROOT%\vispoolmanager\jetty" vispool-A 8090

2. Locate the newly installed service named Teamcenter VisServletpool-ID in the list of Windows
services.

3. Right-click the service name and choose Properties.

4. On the Log On tab, enter logon credentials for the domain user account under which the service
runs.

Visualization Server Manager requires an FMS client cache (FCC) to cache files. Use a dedicated
account to run this service, not the Local System account.

Windows attempts to run the service automatically by default. If the service is not already running,
a problem may have occurred.

If you set the service to start manually in its Properties, then you can click Run from the toolbar to
start the service, or right-click the service in the Services window and choose Start.

To stop the service, either click Stop Service on the toolbar, or right-click the service and choose
Stop.

To uninstall the service, type uninstallservice.bat "Teamcenter VisServlet pool-ID.

Start Visualization Server Pool Assigner

Linux systems

To start Visualization Server Pool Assigner (VPA) on a Linux machine, type the following command:

TC_ROOT/visassigner/run_assigner.sh

Alternatively, you can start the VPA as a daemon by running the installservice.sh command for
each jetty server with admin permissions:

installservice.sh unique-service-name port user 

If you do not specify parameters, the script runs in interactive mode and prompts you for the
information.

7. Post-installation tasks for setting up the Visualization Server
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For example, from the TC_ROOT/visassigner/jetty directory, type:

sudo ./installservice.sh MyUniqueAssigner1 7780 MyUser

Windows systems

To start VPA on a Windows machine, run the following file:

TC_ROOT\visassigner\run_visassigner.cmd

After running run_visassigner.cmd, you can lock the machine, but you must remain logged on. If
you sign out, the VPA is shut down.

Alternatively, you can start VPA as a Windows service only when you are exclusively using
client-side rendering. Windows services cannot access the graphics card, so this is not a suitable
deployment for server-side rendering.

1. To install VPA as a Windows service, run the installservice.bat command:

installservice.bat "%JAVA_HOME%" "VPA-dir" assigner-IDport

Replace VPA-dir with the path to the VPA’s jetty directory. Replace assigner-ID and port with
the ID and port used by Active Workspace Gateway to connect to the Assigner.

For example:

installservice.bat "%JAVA_HOME%" "%TC_ROOT%\visassigner\jetty" VisAssigner-A 
8089

2. Locate the newly installed service named Teamcenter VisServletassigner-ID in the list of
Windows services.

3. Right-click the service name and choose Properties.

4. On the Log On tab, enter the logon credentials for the domain user account under which the
service runs.

Windows attempts to run the service automatically by default. If the service is not already
running, a problem may have occurred.

If you set the service to start manually in its Properties, then you can click Run from the
toolbar to start the service, or right-click the service in the Services window and choose Start.

To stop the service, either click Stop Service on the toolbar, or right-click the service and
choose Stop.

Start Visualization Server Pool Assigner
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To uninstall the service, type uninstallservice.bat "Teamcenter VisServlet assigner-
ID".

Start Visualization Data Server

To start Visualization Data Server Manager, enter the following command:

Windows systems: TC_ROOT\VisDataServer\Program\VisDataServer.exe

Linux systems: TC_ROOT/VisDataServer/bin/VisDataServer

After the Visualization Data Server is started, it automatically detects and caches product configurations
that have been indexed with the MMV flag. These cached product configurations are ready for fast
visualization with the MMV technology.

For a product configuration is ready for MMV visualization, the following criteria must be met:

• The product configuration has been indexed.

• Visualization Data Server has detected, downloaded, and cached the structure.

• Visualization Data Server has prepopulated the FMS system.

If you attempt to visualize a product configuration that is not yet completely indexed and cached in
the Visualization Data Server, the viewer uses the regular non-MMV mode by default. Changes in the
product configuration need to be re-indexed and reread by the Visualization Data Server before they can
be displayed by the viewer.

Additional configuration for the Visualization Data Server is available in the etc/
VisDataServer.properties file. This includes detailed logging and fine tuning for other settings. If you
make changes to the properties file, you need to restart Visualization Data Server.

Optional: Start the Visualization Data Server as a Linux daemon

To install these services, run the installservice.sh located in the VisDataServer/bin folder. Run this
command with administrator permissions:

installservice.shunique-service-nameuserFMS_HOME

For example, from the VisDataServer/bin/ directory, type:

sudo ./installservice.sh VDS MyUser /VIS/VisServer/FCC

If you do not specify arguments, the script runs in interactive mode and prompts you for the required
values.

7. Post-installation tasks for setting up the Visualization Server
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To uninstall services, run the uninstallservice.sh script for each Jetty server. Run this command with
administrator permissions:

uninstallservice.shservice-name

For example, from the VisDataServer/bin/ directory, type:

sudo ./uninstallservice.sh VDS

If you do not specify arguments, the script runs in interactive mode and prompts you for the required
values.

If you do not remember the name of the service, find it using the following steps:

1. Change to the VisDataServer/bin/ directory or /etc/systemd/system directory.

2. Search for a file named name.service. The name in this file name is the unique-service-name you
specified when you installed the service using installservice.sh.

Optional: Start the Visualization Data Server as a Windows service

1. Make sure the FMS_HOME environment variable is set as a system environment variable, not a
user variable. The VDS runs as a service only if FMS_HOME is a system environment variable.

2. Inspect the VisDataServer.properties file and make sure all file paths specified in it are full paths, not
relative paths.

3. Open a Teamcenter command prompt and change to the root directory of the Visualization Data
Server.

4. Install the Visualization Data Server as a Windows service by running the VisDataServer.exe
command with the /registerService argument:

VisDataServer.exe /registerService /displayName=name/startup=option

Replace name with a display name for the service. Replace option with automatic or manual.

For example:

VisDataServer.exe /registerService /displayName=VisDataServer /startup=automatic

Optional additional arguments:

Start Visualization Data Server
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Argument Description Example
description Specifies a description for the service. /description="VDS for Active

Workspace"

config Specifies a configuration file to load for
the application.

/config="VDSConfig.txt"

After the service is successfully installed, Windows displays the following message:

The application has been successfully registered as a service.

5. Configure the VDS service:

a. In the Windows Services dialog box, locate the VDS service by the name you specified in the
displayName attribute.

b. Right-click the service name and choose Properties.

c. In the Log on tab, enable the service logon with the following options:

• Log on as: Select This account, and then enter the domain and user name, for example,
myDomain\myName.

• Password: Enter and confirm the password for the user account.

Note:

The VDS requires an FMS client cache (FCC) to cache files. Use a dedicated account to
run this service, not the Local System account.

Windows attempts to run the service automatically by default. If the service is not already running when
you open the Windows Services dialog box, the installation may have failed.

If you set the service to start manually, right-click the service name and choose Start. To stop the
service, right-click the service name and choose Stop.

To uninstall the service, run the VisDataServer.exe utility with the /unregisterService argument.

Rebuild VDS repository from scratch

As the VDS repository is updated via deltas containing incremental changes from Teamcenter that
occur as design data evolves, the repository used to support MMV viewing may introduce errors.
To reduce errors, a good practice is to periodically regenerate the VDS repository from scratch. The
default threshold for this scratch rebuild is every 500 delta updates, but this value is configurable by
an administrator. A full regeneration of the VDS repository can be set to occur more or less often,
depending on the observed need.

7. Post-installation tasks for setting up the Visualization Server
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To change the number of deltas that are processed before a scratch rebuild of the VDS repository, set the
MMV_delta_collection_accumulation_limit Teamcenter preference to a value higher or lower than the
default value of 500. This will change how often the VDS rebuilds its repository from scratch.

Note:

To manage the number of delta files that are to be deleted, use the
MMP_PERCENTAGE_OF_DELTA_TO_PURGE preference. Its default value is 100, but based on your
need, you can set it to any value from 10 to 100. Refer to the following table to understand
preference value limits:

If preference value is set to then preference value processed is

<=10 10

10 < value < 100 value

>=100 100

All delta files are deleted when the MMP_PERCENTAGE_OF_DELTA_TO_PURGE preference value is set to
100.

Example:

Set the MMV_delta_collection_accumulation_limit preference value to 500.

In this case, since the value is set to 500, it becomes the maximum delta limit. After 500 deltas are
processed, a completely new mmp file is created.

To delete 100% of the old delta files in the MMV dataset, set the
MMP_PERCENTAGE_OF_DELTA_TO_PURGE preference value to 100. If you want to delete only
10% of the old delta files in the MMV dataset, set the MMP_PERCENTAGE_OF_DELTA_TO_PURGE
preference value to 10.

Visualization Data Server status log settings

Configuration for the Visualization Data Server is available in the etc/VisDataServer.properties file. This
includes detailed logging and fine tuning for other settings. If you make changes to the properties file,
you must restart the Visualization Data Server.

Log information includes the status of all products hosted by the Visualization Data Server.

#
# Status logger settings. The status logger can be of help showing 
the current indexing status
# and also the current and waiting task to be processed.
#
# The interval to generate the status log (see the "Interval" 
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documentation
 for more info).
StatusLogger.StatusInterval=120
# This will output the name of the top level (root) node. 
StatusLogger.ShowRootName = true
# Shows the timestamp of the indexed product.
StatusLogger.ShowTimestamp = true
# Shows the available revision rules of indexed product.
StatusLogger.ShowRevRule = true
# Shows the status of the Spatial JTs.
StatusLogger.ShowSpatialJt = true
# If ShowSpatialJt is true, also shows the file path of the Spatial JTs.
StatusLogger.ShowSpatialJtPath = true
# If ShowSpatialJt is true and a Spatial JT is missing, the string will 
be added 
in from of the path.
# This can be used if a specific string is needed to search for a 
missing 
file (like using the grep utility).
StatusLogger.MissingSpatialJtMessage = (missing)
# Shows all the versions of a product instead of just the latest one.
StatusLogger.ShowAllVersions= false
# Shows the active tasks being processed.
StatusLogger.ShowActiveTasks=true
# Shows any waiting tasks to be processed.
StatusLogger.ShowWaitingTasks=true

7. Post-installation tasks for setting up the Visualization Server
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8. Configuring Teamcenter for visualizing
models in the rich client
Configure Teamcenter for visualizing models in the rich client

Perform the following configurations to visualize models in the rich client:

Procedure

1. Configure FMS client cache.

2. Configure updating session files in Multi-Site environments.

3. Enable confirmation for loading authentication data for session files.

4. Configure Lifecycle Viewer.

5. Add search schemas for the Lifecycle Viewer.

6. Configure Teamcenter to visualize structures with large number of BOM lines.

7. Set up using separate TcServer session for the standalone viewer.

8. Remove argument to use the Lifecycle Visualization embedded viewer.

9. Customize the rich client Viewer view.

10. Configure preferences to specify new types of visualization datasets.

11. Configure automatic markups.

12. Configure image preview.

13. Set Visualization preferences to configure the behavior of Lifecycle Visualization datasets.

Configure FMS client cache

What are TCCS and FCC and why are they required?

The Teamcenter client communication system (TCCS) manages communication and file transfers
between Teamcenter clients and servers. TCCS contains the Teamcenter Server Proxy (TSP) application
which manages HTTP/S communication with a Teamcenter server and provides support for forward
proxy, reverse proxy, and Kerberos authentication.
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TCCS also contains the FMS client cache (FCC), which uploads files from your workstation to a
Teamcenter volume and also downloads requested files from the volume to your workstation. The
Teamcenter lifecycle visualization integration with Teamcenter requires an FCC to transfer volume data
between Teamcenter and the Lifecycle Viewer.

TCCS is normally installed with the Teamcenter rich client. If the Teamcenter rich client is installed on
your machine, most likely no additional installation steps are necessary.

For information on installing TCCS with the Teamcenter rich client, refer to Teamcenter Rich Client
Installation on Windows or Teamcenter Rich Client Installation on Linux within the Teamcenter
documentation.

Configure FCC to view data from multiple Teamcenter servers

If you plan to view data from multiple Teamcenter servers such as Teamcenter, Teamcenter engineering
process management, and Teamcenter Enterprise, the various databases may not be coordinated with
the viewer. You can connect to only one server at a time with a single File Management System (FMS).

You must install either separate rich clients for these servers or the FMS client caches (FCCs).

To enable viewing visualization data, update the fcc.xml file for each Teamcenter server — 

1. Contact your Teamcenter administrator for the following information about each server for each
Teamcenter product that you want to view visualization data from:

• The site ID number

• The parentfsc address

2. Open a command window on your machine and navigate to teamcenter-product-installation-
directory\tccs\bin.

Example:

d:\tc\2412\tccs\bin

3. At the command prompt, type: fccstat –stop –kill.

4. Navigate to teamcenter-product-installation-directory\tccs.

5. Open the fcc.xml file in a text editor and search for the following string: external site access
definition.

6. Update the site information by adding the following attributes and their values:

<site id=”site number” overridable=”true”>

8. Configuring Teamcenter for visualizing models in the rich client
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<parentfsc address=”URL” priority=”1”/>

</site>

Example:

<site id=”101010101” overridable=”true”>

<parentfsc address=”http://tcentserver:4444/” priority=”1”/>

</site>

7. If you have multiple Teamcenter product servers and you want to view visualization data from all of
them, add the site information for each server.

Note:

• For each additional <site> entry that you add to the fcc.xml file, in the <parentfsc> tag,
increment the value of the priority attribute, so that each entry has a different priority.

• You can only connect to a single server at a time.

8. Save the fcc.xml file.

9. At the command prompt, type: fccstat –start.

If your machine has multiple FCCs and you want to view visualization data from a particular product,
your machine's FMS_HOME environment variable must point to the location of the product's FMS.

To check or change the value of the FMS_HOME environment variable — 

Note:

A TCCS/FCC stop is required before updating the FMS_HOME variable.

Windows Linux
1. Right-click My Computer and select Properties.

2. In the System Properties dialog box, click the
Advanced tab.

3. On the Advanced page, click Environment
Variables.

4. On the Environment Variables page, in the User
variables section, find FMS_HOME and verify that

1. In the shell window from which the
software product was launched, type
echo $FMS_HOME.

A path to the installation of that
product is displayed.

2. Check the path to verify that the
FMS_HOME environment variable is
pointing to the right product.

Configure FCC to view data from multiple Teamcenter servers
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Windows Linux
its path refers to the installation path of the product
from which you want to load visualization data.

5. If necessary, change the path as needed.

Example:

d:\tc\2412\tccs

3. If necessary, change the path as
needed.

Example:

.../tc/2412/tccs

Configuring FCC for background file loading

Using background file loading for large JT models may improve the performance of subsequent analysis
operations, for example, creating a cross section of a vehicle engine. Background file loading uses
secondary processing when the system is idle. Initial file rendering caches JT file fragments that support
displaying the model in the viewer. Once the initial rendering is complete, background file loading uses
secondary processes to begin streaming complete files that you selected. During this process your users
can view, rotate, and interact with the model; however, they might interrupt background loading or
defer it to a later time because the primary viewer rendering takes higher priority. For example, cutting a
cross-sectioning may defer the background loading to a later time.

To enable background file loading, you must first configure File Management System (FMS) client caches
(FCCs). Consider the following when you configure FCC:

• Load your JT data from Teamcenter. This feature only supports working with managed data and FMS.

• Use or install FCC 9.1 or later.

• Configure the FCC to be large enough to load all the JT files required for visualizing models using a
rich client session. If the FCC cache is too small, not all the JT files will be available during a viewing
session with unpredictable results. For example, the geometry for a part may not be visible, or a
LoadPartException error will be displayed.

Update configuration settings in the fcc.xml configuration file — 

• Set the segment cache to twice the size of the largest model.

Example:

If the largest model is 2 GB, set the segment cache to 4 GB.

• Set the whole file cache to twice the size of the largest model.

8. Configuring Teamcenter for visualizing models in the rich client
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• Review and set MinimumReadCacheAgeMinutes to a longer duration than approximately the time
the end users will be away from an active viewing session. For example, if your users can normally be
interrupted for two hours during an active viewer session, set MinimumReadCacheAgeMinutes to
three hours.

Note:

The initial file rendering performance is not significantly influenced by selecting background file
loading.

For detailed information about installing and configuring FMS and FCC, see the following:

• For more information about installing FCC in Teamcenter lifecycle visualization, see Teamcenter
lifecycle visualization Installation in the Lifecycle Visualization help.

• For more information about Teamcenter FMS, see Introduction to File Management System in
Teamcenter Teamcenter Administration in the Teamcenter help.

• For more information about configuring FCC using fccdefaults, see Teamcenter Teamcenter
Administration in the Teamcenter help.

For steps to select background loading for JT files, see Load JT files using background processing.

Purge cache to make disk space for newer cache files — Cache purging is a process that removes
the oldest files in the FCC whole file cache to make disk space for newer cache files. Minimum values
for cache purging include the size of the segment and whole file caches, and minimum cache file age.
To prevent the application from deleting (purging) model files from your FCC cache, the fccdefaults
options must be set to optimize how you work in your environment.

Example:

• In this example, a model is 8 GBs, but available local disk space is 7 GBs.

Your users can expect poor performance because the entire model cannot be loaded in the
whole file cache. As a result, data is downloaded using segment cache until it writes more
than the allocated data. It is important to note that data is loaded in Teamcenter lifecycle
visualization, but additional time is needed to render all parts.

• In this example, a large model is 2 GBs, and both the whole file and segment cache are set to 1
GB.

The data is downloaded using segment cache. The segment cache automatically purges
the oldest files whenever you access an object, which reduces performance. To resolve the
performance problem, the system administrator should set the both the whole file and segment
cache size to 4 GBs.

Configuring FCC for background file loading
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Note:

If the option, MinimumReadCacheAgeMinutes, has not been exceeded, the cache
increases to support loading the 2 GB model. That is, the cache expands so the 2GB
model is loaded or until the age exceeds its configured value (the default value is four
hours).

• In this example, the cache size grows larger than the segment cache and
MinimumReadCacheAgeMinutes is exceeded.

The default for the MinimumReadCacheAgeMinutes option is four hours. Files in your model
have been downloaded and they are stored in your cache. If a file has not been accessed after
four hours, and you need to access and work with new data, the cache policy is configured to
purge the older files to make room for newer ones.

Configure updating session files in Multi-Site environments

When working in a Multi-Site Collaboration environment, Teamcenter lifecycle visualization session files
referencing dynamic 3D documents may not update correctly. This issue can appear under the following
conditions:

• The session file is created on the master site.

• The session file references dynamic 3D documents.

• The session file and all referenced data are replicated on another site in the network.

• The session file is loaded into Teamcenter lifecycle visualization from a replica site.

To prevent session update failures in Teamcenter lifecycle visualization, perform the following steps to
update the File Locate preferences:

1. Choose File→Preferences→File Locate.

2. In the AutoFile Search Preferences dialog box, click the Document Search Order tab.

3. In the search order list, select Relative File Directory Set.

4. Click Move Up to position Relative File Directory Set above Original File Directory Set in the list.

5. Click Auto Confirm.

8. Configuring Teamcenter for visualizing models in the rich client
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6. Click OK.

Enable confirmation for loading authentication data for session
files

If you save a session file locally in a two-tier Teamcenter environment and then load the session file into
a four-tier environment when two-tier is not running, the authentication data is automatically loaded.

If you prefer that data is not loaded automatically and you want to confirm the loading of data, add the
WEB_default_url_autoconfirm preference, and set it to false.

Configure Lifecycle Viewer

Configure Teamcenter to match viewer version

The Teamcenter rich client and the Lifecycle Visualization embedded viewer must share the same
release. For patches, the viewer must be the same version as the rich client, or newer.

When using a version of the viewer that is newer than your rich client, new viewer features
may not be available if they require rich client or server support. In addition, if a newer
version of the viewer is installed, you must copy the SingleEmbeddedViewer.jar file from the
<viewer_install_location>\Program folder to the <rac_install_location>\rac\plugins folder, overwriting
the older version of the file.

Enable confirmation for loading authentication data for session files
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Manage Teamcenter settings to match viewer file updates

The files used to configure Teamcenter are cached. As a result, if you update the
client_specific.properties or tcviewer.properties files, your changes may not be visible because rich
client could be referencing the cached files. If you are unable to see your changes in the viewer, do the
following:

• Clear the cache by adding the –clean argument to the command line in the shortcut that you use to
start the rich client. Once your changes appear, you can remove the argument from the command
line.

• If you update a JAR file in the ../rac/plugins directory, ensure to replace the original JAR file with the
updated version. Do not retain the original version of the JAR file in the directory.

Specify Lifecycle Visualization licensing options to work with Teamcenter

For Lifecycle Visualization to work in Teamcenter, you must have the appropriate license. The licensing
is required for the Lifecycle Viewer and the Teamcenter embedded viewers. To set the license level,
perform the following steps.

Caution:

These settings must match the licensing configuration available from your Teamcenter license
server. They are set automatically during the client installation and in most cases should not be
modified.

1. Set the visualization service level license

When you create or modify a user in Organization, for the Visualization Licensing Level, choose
the appropriate license for the user: Base, Standard, Professional, or Mockup.

2. Specify the licensing for additional optional applications

a. Open the client_specific.properties file in a text editor. The file is located in the
<RAC_install_location>\plugins\configuration_<version>\ directory on client machines.

b. If the client_specific.properties file does not contain the following line:
PortalViewer_Optional_licenses, add it to the file, and set it to include the names
of applicable functionality options.

The following names of functionality options are not included in the default product
configurations. You must type the values individually, separated by commas to match any
additional licenses you have purchased:

• Simplified_Rendering

8. Configuring Teamcenter for visualizing models in the rich client
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• ECAD

• Analysis

• Path_Planning

• Concept_Desktop

• Collaboration

• Visual_Report

• STEP

• JT_Inspect_Workflow

Example:

PortalViewer_Optional_Licenses=ECAD,Analysis,Path_Planning

3. Build the registry to implement the changes

To implement the changes, run the genregxml.bat file located in the
<RAC_install_location>\portal\registry\ directory on client machines.

Set up rich client commands to open models in the standalone viewer

The options or commands to send Teamcenter-managed visualization data to the standalone application
viewer are not shown by default on the rich client user interface. To enable viewing these commands in
the rich client, you must set the TC_show_open_in_vmu_button preference.

1. In the rich client, choose Edit→Options.

2. In the Options dialog box, select Lifecycle Visualization.

3. Select the Show "Open in Lifecycle Visualization" command check box.

4. Click OK.

In the rich client, the Start/Open in Lifecycle Visualization  toolbar button and the File→Open
in Lifecycle Visualization menu command are displayed.

Set up rich client commands to open models in the standalone viewer
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Configure viewer features for multifield keys

Multifield keys are identifiers assigned to objects to ensure their uniqueness in the database. For
example, if the item business object type is configured to use multifield keys, it is possible to have
two item objects with the same item ID.

Most visualization features support multifield key data without requiring any additional configuration,
with the following exceptions:

• ClearanceDB

The managed product name must include the __PLM_ITEMREV_UID value for the item revision, and
the Clearance.cfgproduct file must include the multifield key properties for the item containing the
product.

• MDS stamping

The MetaDataStamp_template preference must specify the values of the multifield key properties
associated with the item containing the MDS_default_styles_template dataset.

Configure Teamcenter to view Lifecycle Visualization sessions

To enable users to view and work with sessions created and saved in Teamcenter lifecycle visualization,
you must configure the following:

1. Relate the Vis Session dataset to the specific item revision type which you plan to use for sessions.

a. In My Teamcenter, choose Edit→Options.

b. In the Options dialog box, choose General→Item Revision.

c. On the General tab, select the desired Item Revision type selected, for example, Design
Revision.

This specifies the item revision type for which the sessions saved in standalone Lifecycle
Visualization will be available in the Teamcenter rich client.

d. If not already present in Shown Relations, under Available Relations, select Vis Session, and
add it to Shown Relations.

8. Configuring Teamcenter for visualizing models in the rich client
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e. Click Apply, and then click OK.

2. Relate the Vis_Session dataset to the Fnd0AppSession object. Once the Vis_Session dataset is
related to Fnd0AppSession, it should not be modified outside the context of Fnd0AppSession. To
protect this integrity, use the suggested access control lists (ACLs):

a. In Access Manager, add a Has Type condition for Vis_Session on the existing Has
Class(Fnd0AppSession) rule.

b. Add the following properties for the Has Type(Vis_Session) rule.

c. On the General tab, select the desired item revision type to relate, for example, Design
Revision.

Configure Teamcenter to view Lifecycle Visualization sessions
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d. If not already present in Shown Relations, under Available Relations, select Vis Session, and
add it to Shown Relations.

Fnd0AppSession supports the following values:

• Private: Only the owning user may view or modify the session objects. Other users cannot
view the session objects.

• ReadOnly: Only the owning user may modify the session objects. Other users can view the
session objects.

• ReadWrite: All users can view or modify the session objects.

Add search schemas for the Lifecycle Viewer

By default, the following system-defined search schemas are used when performing a search operation
in the standalone viewer and in the Lifecycle Viewer:

• Dataset

• Item

• Item revision

• Part

To add any additional system-defined search schemas, add them as values in the Teamcenter
TC_DIS_Search preference.

Configure Teamcenter to visualize structures with large number of
BOM lines

To avoid server time-out issues when trying to visualize large BOM lines in the Lifecycle Viewer, you
may need to adjust the executionTimeout and maxRequestLength values in the Web.config file of the
Teamcenter web server.

1. Browse to the middle tier installation directory.

2. In the Web.config file, increase executionTimeout to 7200 and maxRequestLength to 131072, as
follows:

<httpRuntime executionTimeout=”7200”maxRequestLength=”131072”/>

3. Clear the cache.

8. Configuring Teamcenter for visualizing models in the rich client
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4. Restart the IIS server, the Teamcenter server, and the Teamcenter rich client.

Set up using separate TcServer session for the standalone viewer

By default, in a four-tier environment, when you launch standalone Lifecycle Visualization from the
Teamcenter rich client, the viewer and the rich client share the same TcServer session. When users
perform a time consuming standalone viewer operation, the rich client may appear to lock up until the
viewer operation is finished. To avoid this, you can configure Teamcenter to create a separate TcServer
session for the standalone viewer.

1. Locate your <rac_install_location>\rac\plugins\configuration_XXX directory.

2. Open the site_specific.properties file in a text editor.

3. If not already present, add the following section:

########################################################################
########

# Share tcserver with standalone Viewer (that also supports sharing).

# on this machine when logging in with the same user credentials.

# Default is true. If desired, change to false before starting the rich
client.

########################################################################
########

#viewerShareSession=true

4. Change the last line from:

#viewerShareSession=true

To:

viewerShareSession=false

5. Save the file and start the rich client.

When you launch the standalone viewer from the rich client, the viewer will have its own TcServer
session.

Set up using separate TcServer session for the standalone viewer
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Note:

Embedded viewers in the rich client are not affected by this property. They will continue to share
the TcServer session with the rich client.

How locale affects embedded viewer behavior

The Lifecycle Visualization embedded viewer launches in the locale of the operating system. For the
embedded viewer to work properly, the operating system locale and the rich client runtime locale must
match.

The -nl argument overrides the Java locale and can cause incorrect behavior in the embedded viewer.
Therefore, if you use the Lifecycle Visualization embedded viewer, do not use the -nl argument when
you launch the rich client.

Customize the rich client Viewer view

The framework for the Viewer view in the rich client uses preferences to configure the Viewer view
to traverse the data model and present a viewer for the selected business object type. When an object
is selected in the rich client, the preference configuration is read, and the correct target viewer is
presented.

You can use the following preferences to configure the Viewer view.

Preference Purpose
defaultViewerConfig.VIEWERCONFIG Use this preference to specify the default Viewer view

configuration by defining which Generic Relationship
Management (GRM) rules to expand and which viewer to use
for each type of object specified in the preference.

For default values, see the
defaultViewerConfig.VIEWERCONFIG preference description.

<viewer-config-ID>.VIEWERCONFIG Use this preference to specify an alternate
Viewer view configuration instead of the
defaultViewerConfig.VIEWERCONFIG preference. This
preference defines which GRM rules to expand, and the viewer
to use for each type of object specified in the preference.

• You can create your own preference using the <viewer-
config-id>.VIEWERCONFIG format for the name. The name
must end with .VIEWERCONFIG.

• To use this preference instead of the default viewer
configuration preference, you must specify the preference
name in the Viewer.VIEWERCONFIGTOLOAD preference.

8. Configuring Teamcenter for visualizing models in the rich client
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Preference Purpose

Note:

There is no default value for the <viewer-config-
ID>.VIEWERCONFIG preference. Enter values for your
own configuration.

For an example of values, see the
defaultViewerConfig_VIEWERCONFIG preference.

Viewer.VIEWERCONFIGTOLOAD Use this preference to specify the Viewer view configuration
to load. This preference must point to a .VIEWERCONFIG
preference name.

By default, this preference points to the
defaultViewerConfig.VIEWERCONFIG preference. To
point to an alternate preference, enter a
<viewer_config_id>.VIEWERCONFIG preference name.

Configure preferences to specify new types of visualization
datasets

For visualization file types defined as dataset business objects by the Business Modeler IDE, but not
associated by default with the Lifecycle Viewer and the My Teamcenter viewer, you must configure each
dataset type for display.

Note:

You must provide unique names for each new dataset type and named reference.

1. Add the names of the custom dataset types to the VMU_Datasets preference.

2. Add the names of the custom references to the VMU_FileSearchOrder preference.

3. If 2D markup layers are valid for these file types, add the names of the custom references to the
TC_DIS_2D_named_ref preference.

4. If 3D markup layers are valid for these file types, add the names of the custom references to the
TC_DIS_3D_named_ref preference.

5. (For the Lifecycle Viewer) Create entries for each dataset type in the TcViewer_properties.txt file.

The TcViewer_properties.txt file is installed in the
installation_directory\Visualization\etc\PLMIntegration directory on client machines containing
standalone viewer installations. This file contains examples of properly constructed dataset type
definitions and comments that describe each of the necessary parameters.

Configure preferences to specify new types of visualization datasets
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6. (For My Teamcenter) Create entries for each dataset type in the
defaultViewerConfig.VIEWERCONFIG preference.

Example:

To enable the viewing of NX .prt files in the My Teamcenter viewer, add the following values
to the defaultViewerConfig.VIEWERCONFIG preference:

UGMASTER.DirectModelViewer=UGPART

UGPART.DirectModelViewer=UGPART

UGALTREP.DirectModelViewer=UGPART

7. (For My Teamcenter) Add the names of the visualization dataset types that contain more than one
named reference to the VIS_multi_file_datasettypes preference.

Note:

Users can view the selected named reference in the My Teamcenter embedded viewer.

Configure automatic markups

Automatic markup functionality enables users to markup 2D and 3D datasets directly along with
nonstandard dataset types. Perform the following steps to enable this functionality within the Lifecycle
Viewer and the embedded viewers that are located within Teamcenter applications such as My
Teamcenter and the Structure Manager.

1. In the Business Modeler IDE application, create a new dataset type, for example DJ_Dwg. The
following is an example of defining the dataset type:

a. In the Tools section, add the PV tool to the List of Selected Tools field.

b. Click References.

c. In the References dialog box, enter the name of the dataset type in the Reference box, for
example, dj_drawing.

d. Enter File in the File/Object box.

e. Enter .jpg in the File box.

f. Enter BINARY in the format box.

g. Click Create to create the new dataset type.

8. Configuring Teamcenter for visualizing models in the rich client
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2. Modify the \com\teamcenter\rac\common\tcviewer\tcviewer.properties file located in the %IPR%
\plugins\com.teamcenter.rac.common_teamcenter-version-number.jar file.

a. Add the name of the newly created dataset type to the DatasetViewer.TYPES property, for
example, add DJ_Dwg.

b. Add the named reference to the DatasetViewer.VIEWSEARCHORDER property, for example,
add dj_drawing.

c. Add the VIEWPANEL for the new dataset type, for example, add Dj_Dwgcom.VIEWPANEL=
com.teamcenter.rac.common.tcviewer.TCTwoDViewer.

3. In the \com\teamcenter\rac\explorer\explorer.properties file, located in the %IPR%
\plugins\com.teamcenter.rac.tcapps_teamcenter-version-number.jar file, add the name of the new
dataset type to the explorer.CONTAINERDATASETTYPES list.

4. In My Teamcenter, choose Edit→Options, and add the dataset type based on the type of markup
required.

For 2D markups For 3D markups
Add the name of the dataset type to the
following preferences:

• TC_DIS_2D_named_ref

• VMU_Datasets

Add the name of the dataset type to the following
preferences:

• TC_DIS_3D_named_ref

• 3DMarkup_relation_primary

• VMU_Datasets
Add the name of the new named
reference, for example, dj_drawing, to the
VMU_FileSearchOrder preference.

Add the name of the new named
reference, for example, dj_drawing, to the
VMU_FileSearchOrder preference.

5. In My Teamcenter, choose Edit→Options, and create a new dataset_type_DefaultChildProperties
preference, where thedataset_type is the name of the new dataset type, for example,
DJ_Dwg_DefaultChildProperties.

Configure image preview

Configure the Image Preview view

The Image Preview view provides quick previews of 2D raster images. To enable viewing 2D raster
images, you can configure 2D dataset types, reference types, and the relation search order by
performing the following steps:

Configure the Image Preview view
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1. Open the tcgrb.properties file, which is located in the com.teamcenter.rac.tcgrb_8000.0.0 plug-
in.

2. Based on your requirement, perform any of the following actions.

To Do this
Specify the 2D datasets to
display

Add 2D dataset types, separated by commas, to the
Thumbnail2DViewer.TYPES property.

Specify the named
reference types to be
searched within a dataset
for an image to display.
Only named references
listed here are valid
candidates for thumbnail
display.

Add named reference types, separated by commas, to the
Thumbnail2DViewer.VIEWSEARCHORDER property.

Specify the order in which
datasets are chosen when
there are datasets attached
in different relations to an
item revision.

Add relation types, separated by commas, to the
Thumbnail2DViewer.RELATIONSEARCHORDER property.

Note:

Images are displayed according to the order specified here,
even if there are valid 2D datasets attached in other relations
to an item revision.

Example:

Thumbnail2DViewer.TYPES=Image
Thumbnail2DViewer.VIEWSEARCHORDER=Image
Thumbnail2DViewer.RELATIONSEARCHORDER=IMAN_reference,IMAN_manifestat
ion,IMAN_Rendering,IMAN_specification

3. Save the file, and then update the plug-in.

Configure the JT Preview

The JT Preview view provides quick previews of .jt parts. To enable viewing .jt parts, you can configure
3D dataset types, reference types, and the relation search order by performing the following steps:

Teamcenter embedded visualization must be installed for the JT Preview tab in the Teamcenter client to
function properly.

1. Open the tctdv.properties file, which is located in the com.teamcenter.rac.tctdv_8000.0.0 plug-in.

8. Configuring Teamcenter for visualizing models in the rich client
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2. Based on your requirement, perform any of the following actions.

To Do this
Specify the 3D datasets to
display

Add 3D dataset types, separated by commas, to the
Thumbnail3DViewer.TYPES property.

Specify the named
reference types to be
searched within a dataset
for a part to display. Only
named references listed
here are valid candidates
for thumbnail display.

Add named reference types, separated by commas, to the
Thumbnail3DViewer.VIEWSEARCHORDER property.

Specify the order in which
datasets are chosen when
there are datasets attached
in different relations to an
item revision.

Add relation types, separated by commas, to the
Thumbnail3DViewer.RELATIONSEARCHORDER property.

Note:

Images are displayed according to the order specified here,
even if there are valid 3D datasets attached in other relations
to an item revision.

Example:

Thumbnail3DViewer.TYPES=DirectModel,DirectModelMotion
Thumbnail3DViewer.VIEWSEARCHORDER=JTPART
Thumbnail3DViewer.RELATIONSEARCHORDER=IMAN_manifestation,IMAN_Render
ing,IMAN_specification,IMAN_Motion,IMAN_3D_snap_shot,
TC_Attaches

3. Save the file, and then update the plug-in.

Configure image preview in Relation Browser

You can configure the image preview in Relation Browser perspective of the rich client by specifying the
relation search order and the view search order in the tcgrb.properties file.

1. Open the tcgrb.properties file, which is located in the com.teamcenter.rac.tcgrb_xxxx.x.x plug-in.

2. Based on your requirement, perform any of the following actions.

To Do this
Specify the order in which
datasets are chosen when
there are datasets attached in

Add relation types, separated by commas, to the
DatasetViewer.RELATIONSEARCHORDER property.

Configure image preview in Relation Browser
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To Do this
different relations to an item
revision. Note:

Images are displayed according to the order specified here,
even if there are valid datasets attached in other relations
to an item revision.

Specify the named reference
types to be searched within a
dataset for an image to display.
Only named references listed
here are valid candidates for
image preview display.

Add named reference types, separated by commas, to the
ImagePreview.VIEWSEARCHORDER property.

Example:

DatasetViewer.RELATIONSEARCHORDER=IMAN_manifestation,
IMAN_Rendering,IMAN_specification,IMAN_Motion,IMAN_3D_snap_shot
ImagePreview.VIEWSEARCHORDER=UG-QuickAccess-Binary,Graphics-
Interface,Markup,Image,JPEG,BMP,Shaded-image

Note:

If the first dataset found does not contain an image file, Relation Browser searches until an
image file is found.

3. Save the file, and then update the plug-in.

Configure image preview in the Summary view

You can configure the image preview in the Summary view by specifying the relation search order and
the view search order in the tcviewer.properties file.

1. Open the tcviewer.properties file, which is located in the com.teamcenter.rac.common.tcviewer
plug-in.

2. Based on your requirement, perform any of the following actions.

To Do this
Specify the order in which
datasets are chosen when
there are datasets attached in
different relations to an item
revision.

Add relation types, separated by commas, to the
DatasetViewer.RELATIONSEARCHORDER property.

8. Configuring Teamcenter for visualizing models in the rich client
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To Do this

Note:

Images are displayed according to the order specified here,
even if there are valid datasets attached in other relations
to an item revision.

Specify the named reference
types to be searched within a
dataset for an image to display.
Only named references listed
here are valid candidates for
image preview display.

Add named reference types, separated by commas, to the
ImagePreview.VIEWSEARCHORDER property.

Example:

DatasetViewer.RELATIONSEARCHORDER=IMAN_manifestation,
IMAN_Rendering,IMAN_specification,IMAN_Motion,IMAN_3D_snap_shot
ImagePreview.VIEWSEARCHORDER=UG-QuickAccess-Binary,Graphics-
Interface,Markup,Image,JPEG,BMP,Shaded-image

Note:

If the first dataset found does not contain an image file, the system does not continue
searching the datasets until an image file is found.

3. Save the file, and then update the plug-in.

Teamcenter preferences

You can use Teamcenter preferences to control various aspects of an application's behavior and
appearance. At their core, preferences are simply a way to store information. They are similar to
environment variables, except that they operate with several layers of permissions.

Where can I get a list of preferences?

There are several sources from which to retrieve a list of preferences and their definitions, such as
Administration data report, rich client, and raw XML export.

Create new group or role preference instances

Depending on your dba or group administrator status, you will either see the entire organization or
just a portion of it. Either way, use the organization chart to navigate to an available group, role, or
user location to view or modify that location's existing preference instances or to create new ones.

Teamcenter preferences
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Export, edit, and importing preferences

You can manually edit preference XML files to create or modify a preference, and then use the
preferences_manager utility to load the XML files, or use the rich client to import the files.

Setting Visualization preferences to configure the behavior of
Lifecycle Visualization datasets

Overview of Teamcenter Integration preferences

Use the Teamcenter Integration Preferences to specify the default behavior of visualization
datasets in Lifecycle Visualization. In the standalone viewer or the Lifecycle Viewer, choose
File→Preferences→Teamcenter Integration to adjust any of the following preferences:

These preferences Do this

Teamcenter Integration
3D Loader preferences

Specify the unit of measurement for PLM XML and Parasolid files loaded
from Teamcenter. Also specify how to load 3D documents containing both
static and configured product structure.

Teamcenter Integration
Session preferences

Control the default save location for session files.

Teamcenter Integration
Markup preferences

Control how new markups are named and whether or not to display
messages during batch modifications.

Teamcenter Integration
Check Out preferences

Specify the default behavior when attempting to load checked out objects.

Teamcenter Integration
Attributes preferences

Control the display of Teamcenter and NX attributes present in visualization
datasets.

Teamcenter Integration
Snapshot preferences

Control how 2D snapshots and 3D product views are saved to Teamcenter.

Teamcenter Integration
Visual Issue preferences

Specify the default behavior for visual issue creation.

Teamcenter Integration
3D Save preferences

Specify how to save 3D documents with both configured and static product
structure.

Teamcenter Integration 3D Loader preferences

Use the Teamcenter integration 3D loader preferences to specify the unit of length for product structure
data sent as a new document to the Lifecycle Viewer or standalone application viewer. You can also
specify how to load 3D documents containing both static and configured structure.

1. Choose File→Preferences→Teamcenter Integration.
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2. Click the 3D Loader tab.

3. In the Document Units section, from the Document Units list, select a unit of measurement.

Note:

• The default unit of length for product structure data sent to the Lifecycle Viewer or the
standalone application viewer is meters.

• Changes to the Document Units preference do not apply to documents that are open
in the session. After modifying the preference, close and reopen your documents for the
change to take effect.

• The Document Units preference is not applicable for structure that is inserted or merged
into an existing document.

• The Document Units preference has no effect on static structure that is opened in the
Lifecycle Viewer or the standalone application viewer. The document unit of length for
static data is specified using the PLM XML units setting in PLM XML Preferences.

4. In the Product Structure section, choose one of the following:

To Do this

Open configured structure according to its
current state in Teamcenter. The most recent
structure configuration is loaded.

Click Configure an updated structure.

For 4GD subsets, replay the subset recipe
before opening the data.

a. Click Configure an updated structure.

b. From the Update subset on load list,
select one of the following:

• No Update

• Replay Recipe

When both configured and static product
structure are available, open the structure
according to its state at the time the session
was saved.

Click Load static structure (structure at time
of session save).

When both configured and static product
structure are available, choose how to load the
structure when you attempt to open it.

Click Ask at load time.

Teamcenter Integration 3D Loader preferences
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5. In the Partitions section, select the Show empty partitions check box if, when viewing partition
hierarchies in the assembly tree, you want to show partitions that have no design element
members. When this option is not selected, empty partitions do not appear.

Teamcenter Integration Session preferences

Use the Teamcenter Integration Session preferences to control how a session file is saved.

1. Choose File→Preferences→Teamcenter Integration.

2. Click the Session tab.

3. In the Default Storage Location section, do any of the following:

To Do this

Save session files with the base document. Click Attach to base document.

Save session files in a new location. Click Alternate location.

Teamcenter Integration Markup preferences

Use the Teamcenter Integration Markup preferences to control how new markups are named and to
display messages during batch modifications.

Note:

The Teamcenter site preference TC_Generate_Markup_Name determines whether dataset names
are hard-coded or generated. This controls the markup name only in Teamcenter. In standalone
Lifecycle Visualization, the generated markup name is always used.

1. Choose File→Preferences→Teamcenter Integration.

2. Click the Markup tab.

3. In the General section, do any of the following:

To Do this

Name new markup datasets as you create them Select the Show New Dataset selection dialog
check box.

Display warning messages during batch
operations

Select the Show warnings during batch
modifications check box.

Display errors that occur during batch
operations

Select the Show partial errors during batch
modifications check box.
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Teamcenter Integration Check Out preferences

Use the Teamcenter Integration Check Out Preferences to specify the default behavior when attempting
to load checked out objects.

1. Choose File→Preferences→Teamcenter Integration.

2. Click the Check Out tab.

3. In the Document Checked Out By section, do any of the following:

To specify how to load documents Do this

When the documents are checked out by
someone else

In the Different user section, choose from the
following options

• Load in read only mode

• Cancel load

• Show warnings

When you have opened the documents in
another application

In the Same User / Different Application
section, choose from the following options

• Load in read only mode

• Break lock and check out

• Cancel load

• Show warnings

When you have already opened the documents
in the viewer

In the Same User / Same Application section,
choose from the following options

• Load in read only mode

• Cancel load

• Show warnings

Teamcenter Integration Attributes preferences

Use the Teamcenter Integration Attributes Preferences to control the display of Teamcenter and NX
attributes present in visualization datasets.

Teamcenter Integration Check Out preferences
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Note:

This preference is applicable for assemblies only. It has no effect on individual JT datasets.

1. Choose File→Preferences→Teamcenter Integration.

2. Click the Attributes tab.

3. In the Teamcenter Attributes tab, select the attributes that you want to display.

Tip:

To select multiple adjacent attributes, click the first attribute, press Shift, and then click the
last attribute. To select multiple nonadjacent attributes, hold Ctrl as you click each item.

4. Click Add.

The selected attributes move to the Displayed Attributes section.

5. (Optional) Select the Use Display Names check box.

The attributes are shown using display names if your database administrator defined them.

6. Close and restart the application.

Note:

• You can also set the attributes to display within Teamcenter. Choose Edit→Options→Index, and
then search for Interop_Vis_Attributes.

• To display attributes that are longer than a single line, your system administrator must have
grouped them into a single, multiline attribute.

Teamcenter Integration Snapshot preferences

Use the Teamcenter Integration Snapshot Preferences to control how 2D and 3D snapshots are saved to
Teamcenter.

1. Choose File→Preferences→Teamcenter Integration.

2. Click the Snapshot tab.

3. In the 2D Snapshot section, do any of the following:
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To Do this

Enter form data on 2D
snapshots

Select the Show attributes form on save check box.

Note:

You can enter data for any custom form fields. Revision and Page
information is entered automatically.

Save a 2D geometry
asset

a. Select the Capture 2D geometry asset check box.

b. (Optional) Adjust the Geometry asset image quality slider.

Adjust the 2D
geometry asset image
quality

Use the slider bar to make adjustments in a range from Good, Better, or
Best.

4. In the Teamcenter Product View section, do any of the following:

To Do this

Add or update 3D
geometry asset for
product views

a. Select the Add or Update 3D Geometry Asset check box.

b. (Optional) Select the Draw Outline check box to generate an
outline of the 3D geometry asset.

Note:

If you do not see the Add or Update 3D Geometry Asset
check box, contact your administrator.

Create an image
capture of the product
view

a. Select the Image Capture check box.

b. (Optional) Select the Use image export dialog check box to
display the Export Image dialog box when you save the product
view. If this option is cleared, the application uses Teamcenter
preferences to control such image capture options as size, file type,
and resolution.

Note:

If you do not see the Image Capture check box, contact your
administrator.

Rename the product
view before saving it

a. Select the Show Snapshot Name Dialog check box to display the
New Teamcenter Product View Dataset dialog box.

Teamcenter Integration Snapshot preferences
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To Do this

b. In the New Teamcenter Product View Dataset dialog box, type a
new name for the product view.

Note:

• Use 3D Product View preferences to modify how Teamcenter product views are processed.

• The 3D Product View preferences are unavailable in the following conditions:

• When you do not send Teamcenter data to Lifecycle Viewer. That is, you must have an active
connection to a Teamcenter server.

• When the Teamcenter protection scope of the preferences is higher than your permission
scope. For example, if your administrator set the preference protection scope to SITE, and
your protection scope is set to USER, the 3D Product View options are unavailable.

• If you have permissions, when you change a product view preference in Lifecycle Viewer you
also change the corresponding Teamcenter preference on the server.

Teamcenter Integration Visual Issue preferences

Use the Teamcenter Integration Visual Issue Preferences to control the default behavior of visual issue
creation.

1. Choose File→Preferences→Teamcenter Integration.

2. Click the Visual Issue tab,

3. Do any of the following:

To Do this

Specify a visual report template From the Issue Type list, select a template.

Note:

Issue Report is the default issue type.
Your organization may also allow you to
choose from additional issue types.

Specify the issue relation to use for snapshots In the Issue Relation for Snapshots section,
choose one of the following:
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To Do this

• Snapshot Before Fix

• Snapshot After Fix

Specify the data type attached to the visual
issue

From the Data Type list, select one of the
following:

• Product View or 2D Snapshot

• Session File

Enter options for visual issue creation each time
an issue is created

Select the Ask at the time the Issue is created
check box.

Teamcenter Integration 3D Save preferences

Use the Teamcenter Integration 3D Save Preferences to specify how to save 3D documents that contain
both configured and static product structure.

1. Choose File→Preferences→Teamcenter Integration.

2. Click the 3D Save tab.

3. In the Product Structure section, do any of the following:

To Do this

Specify to save configured structure only Select Save only configured structure.

Specify to save both configured and static
representations of the current structure

Select Save configured and static
representations of the current structure.

Teamcenter Integration 3D Save preferences
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9. Configuring Visualization to work with
Active Workspace
Tasks to configure Visualization to work with Teamcenter Active
Workspace

Perform the following tasks to set up Visualization to work with the Teamcenter Active Workspace.

Configure the locale for Visualization Server Manager

You can configure the Active Workspace client to display the user interface in any of the supported
Teamcenter locales. However, some visualization data, such as Product and Manufacturing Information
(PMI), requires Visualization Server Manager (VSM) configured for the same locale as the information.
For visualization data to display correctly in Active Workspace, you must have at least one VSM
configured to run in each locale that you support. With a VSM in place to support each localization
being used, visualization processes are then routed to the appropriate server based on locale.
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VSMs can be configured to support the following languages:

Brazilian Portuguese

Chinese (Simplified)

Chinese (Traditional)

Czech

French

English

French

German

Italian

Japanese

Korean

Polish

Spanish

Russian

You can configure a VSM with any one of these languages. If you want to configure a cluster of VSMs to
support more than one language, you need at least one VSM per language.

To change the language of a VSM, set the operating system (Windows or Linux) to the required
language, location, and locale:

For Windows systems

1. Adjust the required language, location, and locale using the Region and Language options found
in the Windows Control Panel.

2. Adjust the Date and time formats, the Current location, and the Current language for non-
Unicode programs values.

3. Reboot the system after changing your Windows settings.

When the VSM is started again, it inherits the new language configuration of the operating system.

For Linux systems

1. Run the following command to list all languages currently available on the machine: locale -a. 

2. To configure the VSM to support a particular language, set the environment variables LANG or
LC_ALL in the jettyservice.properties file.

Example:

To set the VSM to run using the German UTF8 locale, set these values in the
jettyservice.properties file:

• VisPoolProxy.envset.LANG = de_DE.utf8

• VisPoolProxy.envset.LC_ALL = de_DE.utf8

9. Configuring Visualization to work with Active Workspace
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Note:

Some Asian locales may require a restart of the Visualization Server to force the necessary
fonts for the desired language to load correctly.

If all VSMs are configured to use the same language, all clients use the available language regardless of
browser preferences.

Note that if you have a VSM system configured for two or more different languages, then Siemens
Digital Industries Software highly recommends that at least one VSM be configured for English, even
though this may require a minimum of three VSMs. When the server system is configured with multiple
languages, if at least one VSM is configured for English, then the English locale is a default.

The following table shows the VSM system response to a visualization data request from a client when
the client is not in one of the preconfigured languages.

VSM system configured for two or more languages Client is not in a preconfigured VSM language
VSM for English exists. The data request is routed to an English VSM.
No VSM for English. The data request is rejected.

Specify the address for the Teamcenter SOA service

You can specify the Teamcenter SOA service address, which is the context root for the Teamcenter
instance. In some reverse proxy deployments, the Visualization Pool Manager cannot access the
outside reverse proxy address due to a firewall. This address is used to provide a direct path from the
Visualization Pool Manager to the main Teamcenter SOA stack.

Enter the Teamcenter SOA service address using your preferred installation tool (Deployment Center or
TEM).

Deployment Center

1. Log on to Deployment Center and select your environment.

2. Proceed to the Components tab and select the Visualization Pool Assigner component to display
its parameters.

3. In the Teamcenter 4-tier URL parameter, type the server side four-tier URL, and then click Save
Component Settings.

4. If any components do not show a COMPLETE status of 100%, update each component in turn until
all components are fully configured and the Deploy tab is enabled.

Specify the address for the Teamcenter SOA service
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5. Go to the Deploy tab. Click Generate Install Scripts to generate deployment scripts to update
affected machines. When script generation is complete, note any special instructions in the Deploy
Instructions panel.

6. Locate deployment scripts, copy each script to its target machine, and run each script on its target
machine.

For more information about running deployment scripts, see Deployment Center ─ Usage.

Teamcenter Environment Manager (TEM)

1. Launch TEM in maintenance mode and proceed to the Feature Maintenance panel.

2. Select Visualization Server Pool Assigner (Java EE) or (.NET)→Update Visualization Server Pool
Assigner configuration, and click Next.

3. In the Visualization Server Pool Assigner Settings dialog box, type the server side four-tier URL in
the Server Side 4-Tier URL box.

4. Proceed through the remaining panels in TEM, entering the required parameters for the
components you selected.

For information about each panel, click the help button .

5. When TEM displays the Confirmation panel, click Start to begin installation.

Configure TCCS environments for Visualization

If you are using a TCCS environment for Teamcenter, you must set up a separate TCCS environment for
the Active Workspace URL in order to open models in standalone Visualization from Active Workspace.  
The Active Workspace URL must be added in addition to the Teamcenter URL.

Follow the instructions in the Teamcenter help, Install TCCS using the stand-alone installation wizard, to
add another URL like this: http://servername/awc/tc.

Configuring the Visualization server

Configure the 2D viewer

The 2D viewer allows you to view additional 2D file types in Active Workspace.

Why would I use the 2D viewer?

The 2D viewer (Awp02dViewer) is one of the individual viewers that are part of the universal viewer
and can render certain files that the Image Viewer (Awp0ImageViewer) cannot. When first installed, it
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renders the HPGL, DXF and TIF file types, but it can be configured to view many more. Some of the more
common file types are:

• NX drawing files (PRT)

• Solid Edge drafts (DFT)

See the Teamcenter Visualization documentation on Support Center for a full list of supported 2D file
types.

How do I make the 2D viewer available?

For the 2D viewer to be available to the universal viewer, the following Visualization Server components
must be installed:

• Visualization Server Manager (server)

• Visualization Server Pool Assigner (server)

• Active Workspace Visualization 2D viewer (client)

How do I configure new file types?

1. Tell the universal viewer to use the 2D viewer for your file type.

For each file type you want the 2D viewer to use, add a new line to the
AWC_defaultViewerConfig.VIEWERCONFIG preference or modify an existing line to change the
viewer type to Awp02dViewer. Verify that there are no duplicate dataset types in the list.

datasetType.Awp02dViewer=namedReference

2. Tell Teamcenter Visualization to open the file type. Add a new value to each of these two
Teamcenter preferences containing the dataset type and the named reference.

VMU_Datasets – datasetType

VMU_FileSearchOrder – namedReference

Example:

You want to use the 2D viewer to render your NX drawings.

NX drawings are stored in UGPART and UGMASTER datasets. Normally, these datasets are viewed
in the image viewer (Awp0ImageViewer), which uses the UG-QuickAccess-Binary reference.

You need to set the universal viewer preference to use the 2D viewer for those dataset types
instead of the image viewer.

Configure the 2D viewer
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Find and edit the existing lines for the two dataset types.

UGMASTER.Awp0ImageViewer=UG-QuickAccess-Binary
UGPART.Awp0ImageViewer=UG-QuickAccess-Binary

Change them to the new viewer and named reference.

UGMASTER.Awp02dViewer=UGPART
UGPART.Awp02dViewer=UGPART

Next, add the dataset values to the VMU_Dataset preference.

UGMASTER
UGPART

Finally, add the named reference value to the VMU_FileSearchOrder preference.

UGPART

Configure Visualization where Teamcenter is deployed behind a load
balancer

You have two options when configuring Visualization in an environment where Teamcenter is behind a
load balancer.

Option 1

Set up Teamcenter in a cluster, and then configure it behind a load balancer. For more information on
setting up Teamcenter in a cluster, see Overview of clustered deployment in the Teamcenter Help.

Note:

The Teamcenter load balancer URL cannot be used as the SOA URL unless Teamcenter is deployed
in a cluster.

Option 2

Deploy Teamcenter and Active Workspace behind a load balancer—preferably on the same application
server. Use localhost for configuring the Active Workspace SOA URL. You will still achieve load balancing
since the client requests are coming in through the load balancer.

You must generate separate Active Workspace gateway deployments, each configured with its own
VisAssigner, in the following situations:

• If you must deploy Teamcenter on a separate application server.
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• If the Teamcenter SOA URL needs to be configured with a valid domain name in your environment.

Disable application pool recycling for visualization

You can use IIS Manager to recycle application pools; however the Visualization Pool Assigner does not
support recycling.

When an application pool is recycled, stored information about client connections, health, and model
sizes is cleared. This causes errors, typically socket exceptions, in the connected Visualization Server
Manager. These exceptions are difficult to resolve and stop the Visualization Server Manager. Because
of this condition, settings for the application pool containing the Visualization Pool Assigner must be
updated to disable recycling.

You must set these two settings in the IIS Manager Advanced Settings for the application pool that
contains the Visualization Pool Assigner:

• Under Recycling, set Regular Time Interval to 0.

• Under Process Model, set Idle Time-out to 0.

Disable application pool recycling for visualization
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Enable Visualization Server Manager logging

The Visualization Server Manager logs contain system information that you can use to identify and
resolve problems.

• Create the following environment variables:

Name Value

TCVIS_DA_DEBUG_LOG True

Note:

For this environment variable, the value of
True is case sensitive.

TCVIS_LOGGING_LEVEL Any of the following:

ERROR
INFO
DEBUG

TCVIS_LOGGING_PATH A valid path to the location where you want
the system to write the log files. If this
environment variable is not set, the generated
VisView#####.log file, which is one log file per
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Name Value

VisView process, is placed into the jetty’s TEMP
directory. If this environment variable is set, all
log files are placed into one file, which may make
it more difficult to determine which process each
log event came from.

If TCVIS_DA_DEBUG_LOG and
TCVIS_LOGGING_LEVEL are set properly, this is
an optional parameter.

Example:

With TCVIS_LOGGING_LEVEL set to DEBUG, the log files include information about how the
system is using OpenGL. When setting up the Visualization Server hardware, you can use this
information to ensure the graphics hardware is operating as expected.

For example, the information in the sample output below indicates the system is not configured
properly, because it is utilizing software rendering.

Running on GL_VERSION: 1.1.0 (1.1.0 supported by driver)
Running on GL_VENDOR: Microsoft Corporation
Running on GL_RENDERER: GDI Generic 

Note:

When a Visualization Server process crashes, a log file with crash information is always written.
If Visualization Server logging is not enabled, the log file is written to the system TEMP
directory.

Configure the Visualization Pool Assigner for JMX metrics

On Windows systems, the Visualization Pool Assigner exposes a variety of useful information through
JMX, but not all of this information is available automatically. Due to stability risks, the following JMX
metrics are unavailable for the Visualization Pool Assigner without special configuration:

• computerCpuUsageRatio
• computerMaxBandwidthBytesPerSec
• computerMemUsageRatio
• computerNetworkUsageRatio
• computerTotalMemMB
• loadRatioAbsolute
• loadRatioRelative
• visSysCpuUsageRatio
• visSysMemUsageRatio
• visSysNetworkUsageRatio

Configure the Visualization Pool Assigner for JMX metrics
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Although these metrics appear in a JMX client, their values are not populated with useful information. To
enable these JMX metrics for your Visualization Pool Assigner, you must copy a provided DLL into the
path of the Java servlet container hosting your Visualization Pool Assigner. 

The following steps are supported on a Windows host only.

1. Locate the Visualization Pool Assigner web application, vispoolmanager.war, in the
visassigner\jetty\webapps directory on your system.

This file is created by the Teamcenter installation tool (Deployment Center or TEM).

2. Unzip the web application .war file to a local directory.

3. Navigate to the WEB-INF\lib\ directory and locate the vis-proxy.jar file.

4. Open this .jar file in a supported ZIP file utility and extract the Metrix.dll file.

5. Add the location of Metrix.dll to the path of the server that hosts your Visualization Pool Assigner.
The easiest way to do this is to find the script that starts the server, or to create a new script to start
the server if one does not already exist. In the script, prepend the location of the Metrix.dll to your
path.

Example:

If you place Metrix.dll in C:\foo, add the following command to the script:

set path=C:\foo;%path%

6. Restart the Visualization Pool Assigner.

If the Visualization Pool Assigner fails to find Metrix.dll, the console window displays the following
warning during startup:

The Metrix library could not be loaded. Some system performance metrics
are unavailable to JMX clients.

If the Visualization Pool Assigner succeeds in finding Metrix.dll, no warning is displayed and the
JMX metrics are populated with meaningful data.

Configure user service level

The pages, panels, and features used for visualizing 3D data are available to users based on their
Visualization service level license: Base, Standard, Professional, or Mockup.

There are three ways to configure user service levels:
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• Enter the value for the correct service level for the Visualization Licensing Level option when
creating or managing a user in Active Workspace.

• Select the correct service level for the Visualization Licensing Level option in the Teamcenter
Organization application.

• Use the command line make_user utility:

make_user -u=Tc-admin-user -p=password -g=group
    -user=aw_test_4 -vislicenselevel=mockup -update

Configure the Active Workspace viewer for HTTPS

Configure Visualization Server components to run the Active Workspace viewer using HTTPS protocol.

Procedure

1. Install the Visualization Server Pool Assigner (VPA) and Visualization Server Manager (VSM) as
described in the Teamcenter installation guide for Windows or Linux.

2. In Deployment Center, in the Components task, select Active Workspace Gateway. Select the
Override Connection check box, and make sure the URL shown begins with https.

3. In the Deploy task, click Generate Install Scripts to generate deployment scripts, and then run
scripts to deploy the VPA and the VSM.

4. Configure the Visualization Server Pool Assigner:

a. Navigate to the jetty directory for the VPA and obfuscate the keystore password:

java -cp lib/jetty-util-11.0.18.jar 
org.eclipse.jetty.util.security.Password user keystore-password

OBF:#########################
MD5:#########################

b. Open the start.ini file and make the following changes:

A. Activate the HTTPS and SSL modules:

java -jar start.jar --add-to-start=https,ssl

B. Ensure that the "#--module=http" line is commented out.

C. Verify the HTTPS and SSL modules are active:

Configure the Active Workspace viewer for HTTPS
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--module=https
--module=ssl

D. Locate the line that contains the jetty.ssl.port setting. Set the port for the VPA as
follows:

jetty.ssl.port=VPA-port

The VPA port was set when you installed the VPA. The default port is 8089.

E. Enable SSL settings:

jetty.sslContext.keyStorePath=relative-path-to-keystore-file
jetty.sslContext.trustStorePath=relative-path-to-truststore-file
jetty.sslContext.keyStorePassword=OBF:################## 
(from step 3.a.)
jetty.sslContext.keyStoreType=<JKS|PKCS12>
jetty.sslContext.keyManagerPassword=OBF:################## 
(from step 3.a.)
jetty.sslContext.trustStorePassword=OBF:################## 
(from step 3.a.)
jetty.sslContext.trustStoreType=<JKS|PKCS12>

For the OBF:################## values, use the value you entered in step a.

F. Save the changes to the start.ini file.

5. Configure the Visualization Server Manager:

a. Navigate to the jetty directory for the VSM.

b. Open the jettyservice.properties file, make the following changes, and then save the file:

VisPoolPropxy.poolUrl=https://server-name:VSM-port/VisProxyServlet

c. Copy the start.ini file from the jetty directory of the VPA to the jetty directory of the VSM.

d. In the copied start.ini file, modify the following entry:

jetty.ssl.port=VSM-port

The VSM port was set when you installed the VSM. The default port is 8090.

6. Copy the certificates file to the vispoolmanager/VisServerFV/etc/certs directory.

7. Configure Teamcenter client communication system (TCCS):
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a. Navigate to the tccs directory.

b. Edit the fcc.xml file. Make sure the parentfsc address specifies https.

<parentfsc
          address="https://fcc-server-name:fcc-port/" priority="0"
      transport="lan"/>

8. If you configured the Active Workspace Gateway for HTTPS in step 2, skip this step.

Otherwise, configure the Active Workspace Gateway by modifying the config.json file:

a. Navigate to the microservices/gateway-1.6.0 directory.

b. Edit the config.json file. Make sure the target address specifies https.

"vis": {
"path": "/VisProxyServlet",
"target":"https://VPA-server-name:VPA-port/VisProxyServlet"
},

c. Restart the Teamcenter Process Manager service.

Configure the viewer for a Security Services-enabled environment
(Teamcenter 11.x)

If you are using Teamcenter version 11.x, the following must be configured to use Active Workspace
viewer if Security Services (SSO) is enabled:

1. Deploy a single login service in applet mode to be used by Visualization as well as the Active
Workspace client.

2. Enable the Teamcenter thin client for Security Services and configured with a Login Service that is
deployed in applet mode. See Security Services Configuration in the Teamcenter help.

• You must configure the Identity Service with two appID values, one for Active Workspace and
another for Teamcenter thin client.

• The Teamcenter server must be configured for single sign-on with both appID values separated
by a comma or a space.

appID value
Active Workspace appIDAW
Teamcenter thin client appIDTC

Configure the viewer for a Security Services-enabled environment (Teamcenter 11.x)
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appID value
Teamcenter server appIDAW, appIDTC
Teamcenter rich client (not required for viewer) appIDTC

3. Once configured, perform the following actions:

a. Verify you can log onto the Teamcenter thin client from the Visualization Server machine. You
may need to enable Java applets for the browser.

b. Specify the address for the Teamcenter SOA service. 

Note:

Ensure you add a trailing slash (/) to the end of the URL.

Note the following points:

• After working in an Active Workspace session for more than 10 hours, the viewer may fail to launch.

In this case, sign out of Active Workspace and sign in again to open the viewer.

• If you remain signed in overnight, Security Services may time out.

If it does, sign in again.

Optimizing the Visualization Server performance

Optimize Visualization Server system performance

Visualization Pool Assigner and Visualization Server Manager have several configuration parameters that
impact server scalability, that is, how many Active Workspace users can open 3D viewers before the
Visualization Servers are considered too busy to accept any further users.

• Timeouts

When an Active Workspace client opens a model in a 3D viewer, a corresponding server data
container is opened in a VisView process on the Visualization Server. A single server VisView process
may contain several data containers from different clients' viewers.

Each VisView process and each user it supports also consume server resources. When a client viewer
is terminated, for example, by the user logging out of Active Workspace or closing the browser tab,
an opportunity to release server resources arises. The serverPollingTimeIntervalS parameter controls
the length of time that the viewer process waits to release the Teamcenter server processes following
the termination of a user’s viewer session.
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However, if a client viewer is not terminated but merely becomes inactive, a timeout period may
be set that releases server resources. The following settings provide a way to control this timeout
behavior.

Variable Default
Value

Definition Location File

clientTimeoutS
(user idle
timeout)

900 (15
min)

A client viewer is
considered inactive if it
does not cause any http
traffic to the Visualization
Server. When a client
viewer is inactive for
clientTimeoutS seconds,
then the corresponding
server document is
closed.

Pool
Assigner

%TC_ROOT%\visassigner
\jetty\jettyservice.properties

Note:

By default, the
jetty.service.properties files
are not included.

timeoutS
(process idle
timeout)

1800
(30 min)

A VisView process is
considered inactive if all
of its connected clients'
viewers are inactive.
When a process is inactive
for timeoutS seconds,
then it is terminated.

Server
Manager

%TC_ROOT%\
vispoolmanager\jetty\
jettyservice.properties

These timeout settings play a role in the tradeoff between server scalability and client user
convenience. Decreasing the timeout values may allow more users access to the Visualization Server,
by more quickly releasing unused server resources from inactive users. However, it may also cause
more inconvenience to individual users by triggering more reconnection events. Reversely, increasing
the timeout values causes users less viewer reconnect interruptions but increases overall server
resource usage, which allows fewer users access to the server.
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Example:

Suppose a Visualization Server is configured with the default timeout values, and it has a single
VisView process with 2 documents, each connected to a client viewer. The first client viewer
becomes inactive, that is, there is no more HTTP traffic to its document. After 15 minutes
of inactivity, the first document is closed, leaving only the second document in the VisView
process. The second client viewer becomes inactive some time later. After 15 minutes of
inactivity, the second document is also closed, leaving the VisView process with no document.
The process is not terminated immediately, as it contains cached data that might be useful for
a suitable client viewer that might connect. However, the process is terminated after another
15 minutes, namely the difference between the Visualization Server Manager timeoutS and
the Visualization Pool Assigner clientTimeoutS. This is why the value of the Visualization Pool
Assigner clientTimeoutS should always be smaller than the value of the Visualization Server
Manager timeoutS.

Note:

• If the user accesses the client viewer after it has timed out, that is, Visualization Pool Assigner
clientTimeoutS, a message appears warning that the connection is being reestablished, and
the viewer reconnects to the Visualization Server.

• Actions in other, non-viewer interfaces of Active Workspace do not affect the viewer inactivity
state. It is defined solely through the HTTP traffic to the Visualization Server, not to the
Teamcenter server.

• When reconnecting, the viewer selection state and visibility state are restored. However, the
navigation state and any state of the viewer panels, such as Measurement and Section, are
not restored.
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• VisView process terminations, that is, Visualization Server Manager timeoutS expirations,
are indistinguishable from process crashes. In the unlikely event of a process crash, the
client viewer reconnects as if it had timed out, according to the Visualization Pool Assigner
clientTimeoutS.

The Visualization Server Manager constantly monitors all VisView processes. If a process becomes
unresponsive to these monitoring requests, then it is terminated. This avoids hung processes
consuming valuable server resources.

Variable Default
Value

Definition Location File

unresponsive-
TimeoutS

180 (3
min)

If a VisView process does not
respond to monitoring requests
for unresponsiveTimeoutS
seconds, it is terminated.

Server
Manager

%TC_ROOT%\
vispoolmanager\jetty\
jettyservice.properties

Note:

• VisView process terminations due to Visualization Server Manager unresponsiveTimeoutS
expirations, are indistinguishable from process crashes. In the unlikely event of a process
crash, the client viewer reconnects as if it had timed out, according to the Visualization Pool
Assigner clientTimeoutS.

• maxBytesPerSec

The Visualization Pool Assigner and Visualization Server Manager both possess a maxBytesPerSec
configuration parameter. This parameter represents the maximum number of bytes per second that
this node may transmit or receive before it rejects requests from users to load new models. The
default value is 125000000 bytes per second. If your server system is consuming too much network
bandwidth, you may want to consider adjusting this parameter.

To modify this configuration parameter for the Visualization Server Manager or the Visualization Pool
Assigner, do the following:

1. In a text editor, open the jettyservice.properties file from the Visualization Server Manager’s
installation or the Visualization Pool Assigner's installation.

2. Adjust the value of the VisPoolproxy.maxBytesPerSec parameter for your server environment.

• maxUsageThreshold

The Visualization Pool Assigner and Server Manager possess a maxUsageThreshold configuration
parameter. This parameter represents the maximum usage and load ratio that any Visualization Server
Manager or VisView process may possess before the Visualization Pool Assigner refuses to allocate
new open model requests to that Visualization Server Manager or VisView process. The Visualization
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Pool Assigner and Server Manager do not assign any more users to a particular VisServer if its system
load, which is an amalgam of network usage, CPU usage, memory usage, and GPU memory usage,
exceeds the given threshold specified with this parameter. The range of values accepted is 0.0 (no
load) to 1.0 (full load).

To modify this configuration parameter for the Visualization Server Manager or Visualization Pool
Assigner, do the following:

1. In a text editor, open the jettyservice.properties file in the Visualization Server Manager’s
installation or the Visualization Pool Assigner's installation.

2. Adjust the value of the VisPoolproxy.maxUsageThreshold parameter for your server
environment.

Enable compression of client-side rendering traffic

When using client-side rendering in Active Workspace Visualization, you can enable gzip compression for
all VisProxyServlet/emm HTTP responses from the Visualization Pool Assigner to the client. To do this,
you use a parameter in the Visualization Pool Assigner configuration file.

1. In a text editor, open the visassigner/jetty/jettyservice.properties file under the Teamcenter
installation directory.

2. Add the following parameter to the file:

VisPoolProxy.allowHTTPResponseCompression=True

Note:

To disable compression, set the value to False. This is the default value.

Activate or deactivate client-side caching in Active Workspace

Client-side caching helps to improve the loading time of a model in Active Workspace.

Procedure

1. On the home page, click the PREFERENCES tile.

Note:

You may need administrative privileges to set preferences.

2. Set the AWV0VisBrowserCaching Teamcenter preference based on your requirement.
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Value Purpose
True (default) Activates client-side caching.
False Deactivates client-side caching.

Set up loading visible parts first in the 3D viewer

In the client-side rendering (CSR) mode, you can specify the CSR loading strategy to load a model faster
in the 3D viewer to improve the user's viewer experience.

To load a model faster, set the AWV0CSRLoadingStrategy Teamcenter preference to useSmartLoading.
In Active Workspace, this allows the 3D viewer to first load the product structure that can be seen from
the current camera view. Then, when loading the geometry, it causes the visible parts to be loaded
before the parts that are hidden.

By default, AWV0CSRLoadingStrategy is set to useSmartLoading. If you do not wish to use any loading
strategy, set AWV0CSRLoadingStrategy to None.

Configure bounding box validation

What is bounding box validation?

Bounding box validation checks for stray parts outside of an assembly. You must define the assembly’s
bounding box by using minimum and maximum X, Y, and Z values.

Parts that are found outside the defined area are not only a potential problem with locator numbers,
drawings, sections, analysis, and so on, but also can cause issues when displaying the assembly in the
3D viewer. For example, if a stray part is located far outside the defined area, when the assembly is fit to
the viewer it may zoom out so far that the parts are merely dots on the screen.

Bounding box validation is only available if the Visualization Data Server is installed.

How does bounding box validation work?

By default, you choose which assemblies need bounding box validation and attach a form to each,
assigning the minimum and maximum values for the bounding box.

Once the form is attached to the assembly and filled out, if a part in that assembly falls outside the
defined area, an entry is logged in the BBoxUpdate.log file located in your system temp directory. You
may assign bounding box validation to as many assemblies as you want by adding a form to each one.

Check this file occasionally to reveal any parts that violate any assigned bounding boxes.

Set up loading visible parts first in the 3D viewer
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How can I further configure how bounding box validation works?

• Change what happens when a part is outside the area.

• Change which form the validator looks for.

• Set a site-wide default bounding box for all assemblies.

• Modify the logging settings.

Attach bounding box forms to assemblies

Use a Teamcenter form to define bounding box validation parameters and assign them to your
assemblies. This ensures that each assembly uses the correct bounding box parameters.

1. Create a form of the type UGPartBoundingBoxForm, and attach it to the top level of the assembly
using the IMAN_requirement relation.

2. Fill out the fields on the form to define the minimum and maximum X, Y, and Z values for the
bounding box.

The system will automatically use this form on this assembly to validate that all parts fall within the
defined bounding box.

Repeat this process for each assembly where you want a bounding box validated.

Changing default behavior for bounding box validation

You can make changes to the default behavior of bounding box validation by modifying
the BBox Validator section of the VisDataServer.properties file, which is located in the
TC_ROOT\VisDataServer\etc directory.

Note:

After making changes to this file, you must restart the Visualization Data Server for those
changes to take effect.

# BBox Validator
# Default BBox limit on the products. A per product limit can be set using a bbox form 
on the Item Revision.
# The BBox units are in meters...
# ProductManager.BBoxValidator.BBoxLimit= -10, -10, -10, 10, 10, 10

# Specifies the suppression to be done on a Node that extends outside of the BBoxLimit.
# The supported modes are the following (FileRef is the default mode):
# Full: The complete Node information is suppressed. Same behavior as no read access on 
a Node.
# FileRef: Any file references are removed. Same behavior as no read access on the 
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attached files.
# None: No suppression will be done. 
ProductManager.BBoxValidator.NodeSuppression= FileRef

# The Relation name used to reference the min/max Form values.
ProductManager.BBoxValidator.FormRelationName= IMAN_requirement
# This is the form type to look for min/max values under the ItemRevision.
ProductManager.BBoxValidator.FormObjectType= UGPartBoundingBoxForm
# The property names on the form to get the values (xmin, ymin, zmin, xmax, ymax, zmax).
ProductManager.BBoxValidator.FormPropertyNames= xmin, ymin, zmin, xmax, ymax, zmax

Change what happens

By default, bounding box validation suppresses the display of any parts that violate the validation
bounding box limits in the 3D viewer, but it still shows the entry in the structure.

To modify this behavior, change the ProductManager.BBoxValidator.NodeSuppression= field
to specify the type of suppression to use. Regardless of this setting, the violation will still be logged.

Type of suppression Result
Full The complete node information is suppressed, both in the 3D viewer and in the

structure, as if the part is not present in the assembly.
FileRef The 3D viewer suppresses the display of the file, but the BOM line entry still

shows in the structure.
None No suppression.

Change the form information

By default, bounding box validation looks for the following properties on specific form types attached to
the assembly with a specific relation:

Form type: UGPartBoundingBoxForm
Relation name: IMAN_requirement
Property names: xmin, ymin, zmin, xmax, ymax, zmax

You can change any or all of these values if you want to use custom forms, properties, or relations.

Provide site-wide default bounding box

By default, bounding box validation only examines assemblies with the specific form attached. You can
uncomment the following line to provide a default bounding box for all assemblies in the database. Any
assemblies that have the form attached will override these defaults.

# ProductManager.BBoxValidator.BBoxLimit= -10, -10, -10, 10, 10, 10

Changing default behavior for bounding box validation
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Modifying the display settings for the 3D viewer

View product views in Active Workspace

An issue report revision is generated with a product view in Teamcenter Lifecycle Visualization and can
be previewed in the 3D mode in Active Workspace.

Note:

The value of the AWC_visProductViewOpenConfiguration preference decides the configuration
setting used while loading product views in the 3D viewer.

Depending on the value set by the administrator, the appropriate product view is displayed. The
default value for this preference is Dynamic.

If the value is set to The product view displayed is

Dynamic Dynamic, where in the product structure is reconfigured
while loading the product view. The 3D viewer displays the
current state of the product.

Static Static, where in the product structure is not reconfigured
while loading the product view. Any modifications made to
the structure after saving the product view are not visible.

Configure measurement precision

The default measurement precision is hundreds on Windows systems and ten thousands on Linux
systems. To change the measurement precision, perform these steps on the machine that hosts the
Visualization Server.

1. Open the registry editor.

Windows systems

Launch the Windows registry editor, regedit.

Linux systems

Type the following command:

Run TC_ROOT/vispoolmanager/VisServerFV/bin/regedit

2. Locate the following registry key:

HKEY_CURRENT_USER\Software\Siemens\AW_Retained\2412\Common\C\Measurement\
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3. Under this key, right-click the Measurement_Precision value and choose Modify.

4. Enter properties for these values:

• Base: Choose Decimal.

• Value data: Type the appropriate value for your desired degree of precision.

Value Precision
0 3
1 3.1
2 3.14
3 3.142
4 3.1416
5 3.14159 

5. Close the registry editor and restart the Visualization Server Manager to enable the registry change.

Specify viewer defaults using Teamcenter preferences

You can specify the default settings for Active Workspace visualization features by changing their
preference values in Active Workspace.

Visualization feature Default Teamcenter preference

3D navigation mode Rotate AWC_visNavigationMode

Front view orientation +Y AWC_visStdViewOrientationFront

Left view orientation +X AWC_visStdViewOrientationLeft

Top view orientation −Z AWC_visStdViewOrientationTop

Aligns standard views with
the X, Y, and Z axes of the
global coordinate system

Automotive AWC_visStandardViewAlignmentMod
e

Display mode (shaded with
edges on or off)

Shaded with edges
off

AWC_visShading

Material Flat AWC_visMaterial

Floor visibility Off AWC_visFloorOn

Floor offset 0.0 AWC_visFloorOffset

Floor orientation XZ AWC_visFloorPlaneOrientation
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Visualization feature Default Teamcenter preference

Floor grid visibility When the floor is
on, the grid is
displayed.

AWC_visGridOn

Reflection visibility When the floor is
on, the reflection
is not displayed.

AWC_visReflectionOn

Shadow visibility When the floor is
on, the shadow is
not displayed.

AWC_visShadowOn

Trihedron visibility On AWC_visTrihedronOn

Uses transparency selection
mode

On AWC_visSelectionDisplay

Shows caps and cut lines on
sections

On AWV0SectionCapsEdgesInitialState

Specifies the default 3D
navigation mode for the
Viewer in the Active
Workspace client

EXAMINE AWC_vis3DNavigationMode

Specifies the default Apply
true shading material mode
for the viewer in the Active
Workspace client

true AWC_applyTrueShadingMaterial

Determines which rendering
technology should be used
in the Active Workspace 3D
viewer by default

CSR AWV0ViewerRenderOption

Determines the zoom
behavior of the Examine
mouse navigation

Push AWC_visExamineZoomIn

Sets the display unit for the
3D viewer

Meters AWC_3DViewerDisplayUnit

Sets the background and part
selection color in the 3D
viewer

White AWC_visColorScheme

Sets client-side caching to
improve the loading time of
a model in Active Workspace

true AWV0VisBrowserCaching
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Configure fitting components in the view

When you use the Fit command to fit components in the view, by default a spherical boundary selects
and fits the components. You can configure the Fit command to fit a 2D box around the model and
annotations and fit that within the 2D viewing area. With this feature enabled, the result can be a closer
view of the parts within the viewing area.

1. Shut down the Visualization Server Manager.

2. Back up the jetty/jettyservice.properties file.

3. Edit the jetty/jettyservice.properties file to add the following line:

VisPoolProxy.envset.TCVIS_FITALL_2DBBOX=True

4. Start the Visualization Server Manager.

Adjust the display resolution for 3D models

When you display and manipulate a 3D model in Active Workspace, the Visualization Server renders
images of the model and sends them to the client viewer for display. The images are typically the
same size as the client viewer. However, if the client viewer is larger than the desktop resolution of the
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Visualization Server, the images are the same size as the server resolution and scaled to fit the client
viewer.

If you expand the client viewer to the point where it exceeds the server resolution, the scaled images
may appear soft, especially the edges of the 3D models. To compensate for this, increase the desktop
resolution on the Visualization Server.

It is recommended that the system administrator consider the maximum client resolution that is needed
to show crisp images, and then set the server desktop resolution accordingly. Note that there is no fixed
overhead to setting a high server desktop resolution, as clients typically use a lower resolution and the
corresponding server rendering and network image transfer happen at that lower client resolution.

Configure display units

Use the AWC_3DViewerDisplayUnit preference to configure the default display unit. The default unit is
Meters. Users can override the default unit using the Displayed dropdown.

Value Units

1 Millimeters

2 Centimeters

3 Meters

4 Inches

5 Feet

6 Yards

7 Micrometers

8 Decimeters

9 Kilometers

10 Mils

Configure support for JT Override children

Add support for the JT Override Children column on the structure table

Complete the following steps to allow the end user to add the JT Override Children column to the
structure table.

1. Create an XML file containing the following:
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<?xml version="1.0" encoding="UTF-8" standalone="no" ?>
<Import>
<Client abbreviation="AWClient" name="AWClient">
<ClientScope hostingClientName="" name="Awb0OccurrenceManagement"
uri="Awb0OccurrenceManagement">
<ColumnConfig columnConfigId="mySampleContentColConfig" sortBy="0"
sortDirection="Descending">
<ColumnDef objectType="Awb0PositionedElement"
propertyName="awv0JtOverrideChildren" width="50"/>
</ColumnConfig>
</ClientScope>
</Client>
</Import>

2. At the Teamcenter command prompt, merge the XML file with any existing column definitions
using the import_uiconfig utility, and specify the desired group and role values for this
functionality.

Set up viewing individual node geometry of overridden subassemblies

When viewing a structure that has an element overridden by a monolithic JT file, only the monolithic JT
file geometry is displayed in the 3D Viewer. No geometry associated with any of the individual child lines
under that element will be loaded or displayed in the 3D Viewer.

To allow the end user to view the geometry overridden by a monolithic JT file by opening the overridden
subassembly in a new tab, uncomment the following line in the Visualization Server Manager’s jetty/
jettyservice.properties file:

#VisPoolProxy.envset.TCVIS_IGNORE_ROOT_MONO_OVERRIDE=True

Note:

To enable this functionality for MMV data, your administrator must set the
ProductManager.IgnoreRootMonoOverride=true in the Visualization Data Server's etc/
VisDataServer.properties file.

Configure the color scheme for the 3D viewer

Active Workspace lets you choose between two schemes, White and Gray Ramp, to change the
background color and the part selection color in the 3D viewing window.

To allow a user to switch between the two schemes, as a site administrator, you can override the default
scheme by changing the value of the AWC_visColorScheme preference.

The default value of this preference is set to White.
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Note:

The scheme of the background color and the part selection color in the 3D viewing window is also
retained for cross sections.

To override the default scheme:

1. On the Home page, click Preferences.

2. Search for the preference AWC_visColorScheme.

3. From the search results, select the instance of the preference that has a Location defined as Site
and Scope defined as User.

4. On the primary toolbar, click New .

5. Click Override . The Add Override panel opens.

6. In the Values section, change the value of the preference to 0 and click Add.

7. A new instance of the preference which has a Location and Scope set to User is created. It appears
in the Preferences search results.
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Note:

To switch between schemes again, change the value of the new preference instance that is
created.

8. Sign out of Active Workspace and sign in again for the changes to take effect. Search for the
product you want to work with and load the 3D viewer.

Note:

The background color and part selection color gets saved within a working session.

To add new color schemes:

1. Add new colors under <Section_Colortheme> in the Initialization.xml file located in the
\vispoolmanager\VisServerFV\etc folder.

Warning:

You must not delete or modify the default schemes that are available with the out-of-the-
box installation. Siemens Digital Industries Software recommends that you add your color
schemes after the default schemes in the file.

<Section_Colortheme>
<Theme Name="Gray Ramp">
<Background3D>
<TopColor red="180" green="182" blue="184"></TopColor>
<BottomColor red="230" green="232" blue="234"></BottomColor>
</Background3D>
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<PartSelection3D red="255" green="255" blue="128"></PartSelection3D>
</Theme>
<Theme Name="White">
<Background3D>
<TopColor red="255" green="255" blue="255"></TopColor>
<BottomColor red="255" green="255" blue="255"></BottomColor>
</Background3D>
<PartSelection3D red="246" green="160" blue="73"></PartSelection3D>
</Theme>
</Section_Colortheme>

2. Update the new values in the AWC_visColorScheme preference.
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Configure selection limit

The number of parts that you can select with a volume select action is dependent on the value of the
AWC_visSelectionLimit site-level preference. Area Select will not permit a user to select more than this
number of items in a single selection action.

Configuring Active Workspace to connect with Lifecycle
Visualization

What is Active Workspace Application Connect?

You can connect Active Workspace and Lifecycle Visualization in your default browser using Active
Workspace Application Connect.

Note:

The ability to connect Active Workspace with Lifecycle Visualization is available only when using
Active Workspace 4.3 or later and Lifecycle Visualization 12.3 or later.

With Active Workspace Application Connect, you can move between Active Workspace and Lifecycle
Visualization to complete work on your data. You can also take advantage of cross-selection where
selections made in either Active Workspace or Lifecycle Visualization are reflected in both applications.

In addition, this also provides the flexibility to open multiple documents in separate browser tabs while
retaining interoperability with Lifecycle Visualization.

Configuration instructions for both connection methods can be found in Configure Active Workspace
for connection with Lifecycle Visualization.

Configure Active Workspace for connecting with Lifecycle Visualization

Active Workspace Application Connect allows users to use the Active Workspace Open in Visualization
command to open their data in the Lifecycle Visualization application connected to a synchronized
Active Workspace session. The connected Active Workspace session can be hosted in the Info Browser
within Lifecycle Visualization, or it can run in any external browser that Active Workspace supports.

When configured to host your connected Active Workspace in the Info Browser inside Lifecycle
Visualization (default configuration), the original Active Workspace session will be replicated in the
internal Info Browser. In this mode, the Active Workspace session hosted in the Info Browser will
be updated to match the originating Active Workspace session each time you select the Open in
Visualization command.

When configured to connect with Active Workspace running in an external browser, Lifecycle
Visualization will launch and connect with a copy of the original Active Workspace session in a new
tab in your default browser. In this mode, a new browser tab containing a copy of the original Active
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Workspace session will be created each time you select the Open in Visualization command from the
original, that is, the unconnected Active Workspace session. Selecting Open in Visualization from an
already connected Active Workspace session refreshes the current session and does not open a new tab.

Actions such as selection or visibility changes are synchronized between Lifecycle Visualization and the
connected Active Workspace session in both modes.

Note:

Because Active Workspace dropped support for Internet Explorer in Active Workspace 6.0,
Teamcenter lifecycle visualization 14.1 and earlier can only host Active Workspace 5.2 and
earlier. Teamcenter lifecycle visualization 14.2 and later can host any supported version of Active
Workspace.

Note:

Set the AWV0LaunchAsSession user preference to False if you are using:

• Teamcenter lifecycle visualization 12.4 or earlier along with a Teamcenter version later than
12.4.

• Teamcenter lifecycle visualization 12.4 or earlier along with Active Workspace 5.0 or later.

Teamcenter lifecycle visualization versions 12.4 and earlier do not understand session information
saved by Active Workspace, but can still load the configured assembly referenced by the session.

Teamcenter preference
or Lifecycle Visualization
environment variable Usage or purpose Setting type
AWV0AWAppConnectMode Determines where the connected Active Workspace

session is launched.

• Off — No connection is created.

• InfoBrowser — (Default) launches the Active
Workspace Application Connect Active Workspace
session in Info Browser within Lifecycle Visualization.

• ExternalBrowser — launches the Active Workspace
Application Connect Active Workspace session in a
new tab of the user's default browser, external to
Lifecycle Visualization.

Teamcenter
preference

TCVIS_DISABLE_WEBVIEW Determines which browser components are used to view
web content in Lifecycle Visualization.

Lifecycle
Visualization
environment
variable
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Teamcenter preference
or Lifecycle Visualization
environment variable Usage or purpose Setting type

• False: Uses Microsoft Edge browser components to
view web content in the Info Browser.

This is the default value.

To host Active Workspace 6.0 or later in the Info
Browser, this setting must be False.

• True: Uses Internet Explorer browser components,
which is useful for supporting web pages containing
Lifecycle Visualization Automation controls.

Active Workspace 6.0 or later cannot be hosted
in the Lifecycle Visualization Info Browser if
TCVIS_DISABLE_WEBVIEW=True.

Host Active Workspace in standalone visualization

You can host Active Workspace in the browser embedded in standalone Lifecycle Visualization. Hosting
is especially useful because if you use the Active Workspace Open in Visualization command to
send data to the Lifecycle Visualization application, then selecting a part in either the hosted Active
Workspace structure or in the viewing window applies the same selection status in both locations. This
behavior is referred to as "cross-selection."

Note:

Because Active Workspace discontinued support for Internet Explorer in Active Workspace 6.0,
Teamcenter lifecycle visualization 14.1 and earlier can only host Active Workspace 5.2 and
earlier. Teamcenter lifecycle visualization 14.2 and later can host any supported version of Active
Workspace.

One-time configuration of the local machine is required.

Configure the local computer to host Active Workspace in standalone application viewer

Host Active Workspace in standalone Lifecycle Visualization

Configure the local computer to host Active Workspace in standalone application viewer

Note:

Prerequisites for this procedure:

Host Active Workspace in standalone visualization
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• The Teamcenter administrator has installed the Active Workspace server extension for
visualization.

• The standalone application viewer software is installed on the local computer.
• A File Management System client cache (FCC) for the Active Workspace Teamcenter database is
configured on the local computer.

1. In the standalone viewer, from the Application toolbar, choose Menu→Web→Edit Links.

2. In the Edit Links dialog box, click Add.

A new link appears in the Link Names list.

3. Type a name for the link, and press Enter.

4. Select the link and then, in the Link URL box, type the Active Workspace address.

5. Add the following text to the end of the address:

?ah=true

Your full address should now resemble the following:

http://<your_aw_deployment>?ah=true

Adding the ?ah=true suffix selects and disables the Display in Info Browser check box.

6. Click OK.

Your new link is now displayed on the Web menu.

7. In the Windows registry, create the following browser emulation DWORD entries.

HKEY_CURRENT_USER
   SOFTWARE
      Microsoft
         Internet Explorer
            Main
               FeatureControl
                  FEATURE_BROWSER_EMULATION
                     visview.exe = (DWORD) 00011000
                     visview_ng.exe = (DWORD) 00011000

Make sure the 11000 DWORD values are in decimal. The equivalent value in hexadecimal is 2AF8.

8. Review the compatibility view settings.

9. Configuring Visualization to work with Active Workspace
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a. Open Internet Explorer.

b. Press Alt to display the Menu bar (or right-click the Address bar and then select Menu bar).

c. Click Tools, and then click Compatibility View settings.

d. Ensure that the following options are turned off.

Display intranet sites in Compatibility View

Use Microsoft compatibility lists

Host Active Workspace in standalone Lifecycle Visualization

1. As needed, configure the local computer to host Active Workspace in standalone application
viewer.

2. In standalone Lifecycle Visualization, from the Application toolbar, choose
Menu→Web→<your_aw_link>.

3. Type your user name and password, and click Sign in.

4. (Optional, but likely desired) In the hosted Active Workspace browser, send visualization data to the
standalone viewer.

Configuring Clearance to display results in Active Workspace

Configure Clearance to display results

Perform the following steps to configure ClearanceDB to work with Active Workspace and display
clearance results.

Prerequisites

Before completing these steps, you must install the 3D Clearance feature in Active Workspace using
Deployment Center or TEM.

Procedure

1. Clone stable IDs.

2. (Optional) Set the default owner for each Clearance result.

3. (Optional) Assign ClearanceDB roles to Teamcenter users.

Configure Clearance to display results
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4. (Optional) Create and export 2D images.

Define ClearanceDB roles in Active Workspace

To protect Teamcenter ClearanceDB data viewed in Active Workspace, assign users to one of the
ClearanceDB roles within the ClearanceDB group, according to your business rules. There are three OOTB
ClearanceDB roles:

Note:

Before assigning users to a ClearanceDB role, you must select the Enable per-user access to the
Clearance Database check box on the ClearanceDB Server Configuration page in Deployment
Center. When this check box is cleared, all users can read and disposition Clearance results in
Active Workspace.

Role Description
Administrator Users can author Clearance data in the database.
Disposition Users can disposition (read/write) ClearanceDB analysis results.
Read only Users can read the Clearance data but cannot modify or disposition the data.

Within the ClearanceDB group, add users to ClearanceDB roles using:

• Active Workspace Administration

• Teamcenter Organization

• make_user utility in Teamcenter command shell

Example:

|user1|user1_password|ClearanceDB|Administrator|description|
Administrative access for Clearance Data Base

|user2|user2_password|ClearanceDB|Disposition|description|Disposition
access for Clearance Data Base

9. Configuring Visualization to work with Active Workspace
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10. Allow users to replace DirectModel
datasets attached to released item
revisions
Consider the scenario where there are JT translators running as a service in end user environments,
translating CAD data to JT. These services might generate data even after an item revision is released.
Based on the practices of your organization, you can allow or disallow this behavior.

To allow updates to a released item revision, you can set up attaching or detaching a DirectModel
dataset from a released item revision.

Procedure

1. On the home page, click the PREFERENCES tile.

Note:

You may need administrative privileges to set preferences.

2. Add the users, who can attach or detach DirectModel datasets as values to the
TC_JTTRANSLATOR_USERS preference.

• All users defined as values of the preference, for example, jackjtuser, can attach or detach
DirectModel datasets to and from an ItemRevision object when it is in a released state.

• Users that are not defined in the preference cannot attach or detach DirectModel datasets to
and from an ItemRevision object when it is in a released state.
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11. Monitoring and Troubleshooting
Visualization
Monitor visualization components in Active Workspace

The Active Workspace Viewer Administration page provides information about active visualization
components, including the server pool assigner, server manager, processes, and connected clients.

1. Log on as a user with administrator privileges.

2. On the home page, click VIEWER ADMINISTRATION.

Tip:

To see the VIEWER ADMINISTRATION tile on the home page, make sure your organization
group and role is mapped to the right workspace.

The Viewer Administration page appears. The initial view of the page includes a diagram of the
server pool assigner, server manager, and the active processes and connected clients.
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3. For details about an object included in the diagram, select the object, and click Information .

The Information panel appears, providing detailed information about the selected visualization
component.

11. Monitoring and Troubleshooting Visualization
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Note:

To maintain a secure environment, sensitive information such as IP addresses and the session
ID is not displayed.

4. To update the information displayed, click Refresh.

Monitoring Visualization server components using JMX

Overview of monitoring Visualization Server components using JMX

You can monitor the Active Workspace Visualization Server system, including the Visualization Server
Manager, Visualization Servers, and the Visualization Pool Assigner, using a freeware Java Management
Extensions (JMX) client, such as Oracle Java Mission Control or JConsole. Monitoring these server
components with JMX is useful for identifying performance bottlenecks or other problems.

A JMX client installed on the same computer as the Visualization Server components automatically
detects all servers running on the machine. The information exposed by the visualization components is
presented using MXBeans.

To set up remote access for JMX clients, you must configure authentication of users and passwords on
the server and encryption for the server process. Once remote access is enabled and configured, JMX
clients from remote machines can connect to the server.

For information about configuring remote JMX monitoring of server processes, see Monitoring and
Management Using JMX Technology in the Oracle Java SE Documentation.

Overview of monitoring Visualization Server components using JMX
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Note:

JMX metrics can include the following composite data types with multiple values:

CurrentMaxTotal: This object includes these values:

• The current value

• The highest the value has been since startup

• The total value since startup

CurrentMaxMin : This object includes these values:

• The current value

• The highest the value has been since startup

• The smallest the value has been since startup

Visualization Server Manager

Each Visualization Server Manager hosts two MXBeans that contain information about its current
state: <poolName> and <poolName> monitoring. They are located in the Administer-<poolName>-
manager folder.

The <poolName> MXBean for the Visualization Server Manager provides the following information:

• CacheConfiguration

The configuration parameters used to connect the Visualization Server Manager to the Visualization
Pool Assigner.

• Language

11. Monitoring and Troubleshooting Visualization
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The language within which the Visualization Server Manager is running.

• Load

A single ratio that represents how much of the computer’s capacity is currently in use. When this ratio
is greater than or equal to 1.0, the system is completely full and new clients are rejected.

• NumberOfAssignedServers

The number of Visualization Server processes in use or recently in use by client users.

• NumberOfColdServers

The number of Visualization Server processes in the process of starting up but not yet ready for use.

• NumberOfServers

The total number of Visualization Server processes, including, cold, warm, and assigned.

• NumberOfWarmServers

The number of Visualization Server processes ready for use by new client users.

• PoolID

The name of this Visualization Server Manager.

• PoolSpecificConfiguration

The configuration parameters passed in at startup to this Visualization Server Manager.

• StartupDate

The data and time that this Visualization Server Manager was last started.

The <poolName> monitoring MXBean for the Visualization Server Manager provides the following
information:

• accepting

Whether this server is currently accepting new incoming users.

• assignedServerCount

The number of VisView processes that are currently serving users with visualization functionality.

Visualization Server Manager
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• assignedVisViews

Specific information about each of the VisView processes that are currently assigned to users.

• assignedVisViewsCount

The number of VisView processes that are currently assigned to users.

• computerCpuUsageRatio

A ratio indicating how much CPU usage is consumed or unavailable on this computer.

Note:

A ratio for Active Workspace MXBeans refers to a current usage value divided by the maximum
usage value. For example, a CPU usage of 30% is divided by the maximum of 100% to compute
a ratio of 0.3. All ratios in Active Workspace are between 0 and 1, unless the capacity of the
visualization system is exceeded, in which case the ratio is greater than 1.

• computerMemUsageRatio

A ratio indicating how much system memory is consumed or unavailable on this computer.

• computerNetworkUsageRatio

A ratio indicating how much network usage is consumed or unavailable on this computer.

• config

The configuration parameters passed in at startup to this server.

• dateCreated

The date and time that this Visualization Pool Assigner was last started.

• gpus

Specific information about each of the GPUs currently used by VisView processes.

• hostName

The name or IP address of the computer that this server is hosted on.

• languageID

The language that the server is currently running in.  The default is English.

11. Monitoring and Troubleshooting Visualization
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• loadRatioAbsolute

A ratio indicating how much of the computer’s resources is consumed or unavailable on this
computer.

• loadRatioRelative

A ratio indicating how much of the computer’s resources are consumed or unavailable on this
computer when compared to the maximum allowed resource consumption level of this server. The
default maximum allowed resource consumption level is 0.7.

• maxBandwidthBytesPerSec

The maximum allowed bandwidth in bytes per second that this server is allowed to consume.

• numAssignmentsSinceStartup

The number of models that have used visualization system resources on this server.

• numGpus

The number of GPUs that the computer has.

• poolName

The alias defined by the administrator to identify this particular Visualization Server Manager.

• Prefers

The models preferred by this server.

• serverTooFullExceptions

When clients are refused visualization services, this contains the reason.

• serverTooFullExceptionsCount

How many clients were refused visualization services.

• serves

The models that this server has currently in memory due to requests from users.

• totalGpuMemMB

The total amount of system GPU memory on this computer.

Visualization Server Manager
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• upTimeSec

How many seconds have elapsed since this server was last started.

• visSysCpuUsageRatio

A ratio indicating the CPU usage of this server on the computer.

• visSysGpuUsageRatio

A ratio indicating the GPU usage of this server on the computer.

• visSysMemUsageRatio

A ratio indicating the amount of system memory consumption of this server on the computer.

• visSysNetworkUsageRatio

A ratio indicating the amount of network usage of this server on the computer.

• warmServerCount

The number of VisView processes that do not yet have users but are ready to host visualization
services for new users.

• warmVisViews

Specific information about the VisView processes that do not yet have users but are ready to host
visualization services for new users.

• warmVisViewsCount

The number of VisView processes that do not yet have users but are ready to host visualization
services for new users.

Visualization Server

Each Visualization Server owned by the Visualization Server Manager hosts one MXBean that
contains information about its current state. The MXBeans for the Visualization Servers are called
VisView@PID_<processID>@Port_<port>. They are located in a folder called VisServers.

An MXBean for a Visualization Server provides the following information:

• ClientConnections

Information about each client user connected to this Visualization Server.

11. Monitoring and Troubleshooting Visualization

11-8  Visualization ─ Deployment and Administration, Teamcenter 2412
© 2025 Siemens



• DateCreated

The date and time that this Visualization Server entered a state where it was first made available to
client users (warm).

• Models

The IDs for the models that this Visualization Server is currently hosting.

• MsSinceLastEMM

The number of milliseconds since this Visualization Server last received a message from a client.

• Port

The port that this Visualization Server is currently hosting its socket server on for connections from
the Visualization Pool Assigner.

• ProcessCpuUsageRatio

The average amount of CPU usage that this Visualization Server has consumed on the Visualization
Server Manager computer over the last 20 seconds.

• ProcessGpu

General information about the GPU that the Visualization Server is using.

• ProcessID

Also known as the PID, this is the identifier that the operating system uses to denote this particular
Visualization Server.

• ProcessMemUsageRatio

The average amount of memory usage that this Visualization Server has consumed on the
Visualization Server Manager computer over the last 20 seconds.

• ProcessMyGpuMemUsageRatio

The average amount of GPU memory usage that this Visualization Server has consumed, of the
particular GPU that this Visualization Server is assigned to, over the last 20 seconds.

• ProcessNetworkUsageRatio

The average amount of network usage that this Visualization Server has consumed on the
Visualization Server Manager computer over the last 20 seconds.

Visualization Server
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• ProcessTotalBytesTransfered

The number of bytes that have been received and sent by this Visualization Server process. This
discounts the data downloaded from Teamcenter servers.

• ServletConnections

Information about each connection from the Visualization Pool Assigner.

• TotalNumEMMs

The number of client requests handled by the Visualization Server.

• UpTimeSec

The number of seconds that have elapsed since the Visualization Server was created.

Visualization Pool Assigner

Each Visualization Pool Assigner hosts two MXBeans that contain information about its current state:
Assigner and Assigner monitoring. The MXBeans are located in the Administer Assigner manager
folder.

Note:

You must configure the Visualization Pool Assigner to populate some of the JMX metrics with
meaningful information. For more information, see Configure the Visualization Pool Assigner for
JMX metrics.

The Assigner MXBean for the Visualization Pool Assigner provides the following information:

• AssignerSpecificConfiguration

The configuration parameters passed to this Visualization Pool Assigner at startup.

• CacheConfiguration

The configuration parameters used to connect this Visualization Pool Assigner to any other
Visualization Pool Assigners in the Visualization Server system, and the configuration parameters used
to identify this Visualization Pool Assigner such that other nodes in the Visualization Server system
can connect to it.

• Load

A single ratio that represents how much of the computer’s capacity is currently in use. When this ratio
is greater than or equal to 1.0, the system is completely full and new clients are rejected.
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• NumberOfPools

The number of Visualization Server Managers that this Visualization Pool Assigner is currently
connected to.

• NumberOfUsers

The number of client users who are currently connected to Visualization Server processes through
this Visualization Pool Assigner.

• StartupDate

The data and time that this Visualization Pool Assigner was last started.

The Assigner monitoring MXBean for the Visualization Pool Assigner provides the following
information:

• clientCount

The number of users that are connected to this server.

• clients

Specific information about the clients that have active sessions with this server.

• computerCpuUsageRatio

A ratio indicating how much CPU usage is consumed or unavailable on this computer.

• computerMaxBandwidthBytesPerSec

The maximum allowed bandwidth in bytes per second that this server is allowed to consume.

• computerMemUsageRatio

A ratio indicating how much system memory is consumed or unavailable on this computer.

• computerNetworkUsageRatio

A ratio indicating how much network usage is consumed or unavailable on this computer.

• computerTotalMemMB

The total amount of system memory on this computer.

• config

Visualization Pool Assigner
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The configuration parameters passed in at startup to this server.

• dateCreated

The date and time that this Visualization Pool Assigner was last started.

• loadRatioAbsolute

A ratio indicating how much of the computer’s resources is consumed or unavailable on this
computer.

• loadRatioRelative

A ratio indicating how much of the computer’s resources is consumed or unavailable on this computer
when compared to the maximum allowed resource consumption level of this server. The default
maximum allowed resource consumption level is 0.7.

• poolCount

The number of Visualization Server Managers known to this server.

• poolManagers

Specific information about the Visualization Server Managers known to this server.

• serverTooFullExceptions

When clients are refused visualization services, this contains the reason.

• serverTooFullExceptionsCount

How many clients were refused visualization services.

• upTimeSec

How many seconds have elapsed since this server was last started.

• visSysCpuUsageRatio

A ratio indicating the CPU usage for this server on the computer.

• visSysMemUsageRatio

A ratio indicating the amount of system memory consumption for this server on the computer.

• visSysNetworkUsageRatio
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A ratio indicating the amount of network usage of this server on the computer.

Troubleshooting Visualization

The following list of issues and possible resolutions address situations that are outside the scope of the
troubleshooting diagnostic sequence for new installations. Additionally, if you are having issues with an
Active Workspace client connected to a Visualization Server, use the Logging feature to record the issues
in a log file to share with Siemens Digital Industries Software support who can help you find a solution.

• Graphics in the viewer tab display extraneous geometry.

• Measurement label dragging does not work with a touch screen.

• The assembly appears to be very small on the screen.

• Indexing fails while using the MMV option.

• Lifecycle Visualization may display a structure differently than it is shown in Active Workspace.

• The Visualization Pool Assigner repeatedly adds the error message: Could not connect to
<HOST>:<PORT>. Retrying..." to the console/log.

• The Visualization Server Manager displays message: Trouble connecting to cold visualization
server on port XXXX with PID YYYYY due to "The VisView's reported system CPU usage (-1.0) is
less than 0". Retrying.

• After a user inactivity exceeds the time out value, the Active Workspace viewer tries
to reconnect but fails with the following error: Visualization was not loaded because
communication was lost.

• When initializing the viewer, you see a spinning circle, but the Viewer never loads.

• The measurement or PMI labels appear very small on the screen.

• Sessions saved in standalone Lifecycle Visualization are not visible in the Teamcenter rich client.

In case there is an issue in the Active Workspace 3D viewer, you can obtain a diagnostic report.

Issue Possible resolution
Graphics in the viewer
tab display extraneous
geometry.

This is an indication that the graphics driver on the Visualization Server
Manager machine is not up-to-date.

Verification

1. On your video card manufacturer’s web site, make note of the latest driver
version for your card.

Troubleshooting Visualization
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Issue Possible resolution
2. Open the Windows Control Panel.

3. Click Device Manager.

4. Expand Display adapters.

5. Right-click the entry for your display adapter, and choose Properties.

6. Click the Driver tab.

The driver version on your machine is listed. If the installed driver is not
the latest available, update it.

Solution

If the driver for the graphics adapter is not the latest version, update the driver
and reboot.

Measurement label
dragging does not
work with a touch
screen.

Solution

In browsers on the Microsoft Surface, you may need to disable the press and
hold setting if you see a translucent square appear when performing the press
and hold gesture.

1. Open Windows search and type Pen and Touch to find the settings dialog
box.

2. In the Touch tab, select the Press and Hold action and click Settings.

3. Uncheck Enable press and hold for right-clicking and click OK.

4. In the Pen and Touch settings dialog box, click OK.
The assembly appears
to be very small on the
screen.

Verification

The existence of bad data from a single part in a large assembly may cause
noticeable visualization artifacts when the whole assembly is viewed in MMV
mode. For example, if one part has a very large bounding box caused by bad
data, the assembly may appear to be very small on the screen.

Review the vds_console.log for this line:

Suspected bad bounding box encountered

VDS provides this warning if it encounters parts with suspicious bounding
boxes. Keep in mind the following items:

• VDS flags nodes with an unusually large bounding box.

11. Monitoring and Troubleshooting Visualization

11-14  Visualization ─ Deployment and Administration, Teamcenter 2412
© 2025 Siemens



Issue Possible resolution
• VDS flags nodes that are isolated from other parts.

• You need at least 1000 nodes in a structure for these calculations to be
made. Otherwise, it would not be statistically meaningful.

To log additional information on boundary box error reporting, create
a log for bounding box validation by adding the following to the
VisDataServer.properties file:

# This channel is meant to capture the output from BBoxValidator 
logger. 
# This will log any invalid Bounding Boxes found in the structure.
logging.channels.BBoxValidatorChannel.class=FileChannel
logging.channels.BBoxValidatorChannel.flush=false
logging.channels.BBoxValidatorChannel.path=${system.tempDir}/
BBoxValidator.log
logging.channels.BBoxValidatorChannel.rotateOnOpen=true
logging.channels.BBoxValidatorChannel.purgeAge=0 seconds
logging.channels.BBoxValidatorChannel.formatter=FileFormatter
  
# BBoxValidator logger
logging.loggers.BBoxValidator.name=BBoxValidator
logging.loggers.BBoxValidator.level=Debug
logging.loggers.BBoxValidator.channel=BBoxValidatorChannel

Use the bounding box validator to define the appropriate bounding box for
your assemblies.

Indexing fails while
using the MMV option.

Verification

When running the FTS Indexer with the Massive Model Visualization (MMV)
option, a folder is automatically generated in case there is a failure:

FTS_INDEXER_HOME\working\TcFtsIndexer_structure\ MMV_Failure 

Solution

If you notice the MMV_Failure folder is created and contains content, contact
Support Center to investigate the issues.

Lifecycle Visualization
may display a
structure differently
than it is shown in
Active Workspace.
This may occur when
Active Workspace
configures its
structures using a
saved variant rule
(SVR) and then

Solution

The PSEShowUnconfigdVarPref preference must be set to false for Lifecycle
Visualization to show the same structure as Active Workspace when variants
are applied. This can be done using the Edit→Options menu command in the
rich client.

The issue can occur depending on the value of the PSEShowUnconfigdVarPref
preference. The Structure Manager application within the rich client allows for
setting a Show Unconfigured Variants flag. When this flag is true, BOM lines
that would normally be removed given the current variant configuration are
shown. The value of the PSEShowUnconfigdVarPref preference is modified

Troubleshooting Visualization
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Issue Possible resolution
interoperates the
configured structure to
Lifecycle Visualization.

each time the state of this flag is modified. Active Workspace does not currently
present this Show Unconfigured Variants flag as a configurable option.
However, the PSEShowUnconfigdVarPref preference is still used by the BOM
window to set its own state regarding whether it shows unconfigured BOM
lines.

Setting the PSEShowUnconfigdVarPref preference to false causes BOM lines
for configurations other than the current one to be removed, displaying the
same configuration data in Lifecycle Visualization that is displayed in Active
Workspace.

The Visualization Pool
Assigner repeatedly
adds the error
message Could
not connect to
<HOST>:<PORT>.
Retrying... to the
console or log.

The Visualization Pool Assigner was likely mistakenly configured to have a peer
Visualization Pool Assigner. Peer Visualization Pool Assigners are intended for
load balanced configurations where there is more than one Visualization Pool
Assigner in the system for improved load handling or failover.

In Deployment Center, open the Visualization Pool Assigner component
parameters and remove the server peer assigner entry.

In TEM, in the Visualization Server Pool Assigner Settings panel, remove the
server peer assigner entry.

The Visualization
Server Manager
displays the
message Trouble
connecting
to cold
visualization
server on port
XXXX with PID
YYYYY due to
"The VisView's
reported system
CPU usage (-1.0)
is less than 0".
Retrying...

The Visualization Server Manager process uses Windows performance counters
to read the current CPU usage of the computer. Windows performance
counters can become broken, resulting in invalid values for the CPU usage,
for example: -1.

Solution

1. Open a command prompt or run PowerShell as an administrator.

2. Change the directory to C:\Windows\SysWOW64.

3. Run the command lodctr /R.

4. Restart the Visualization Server Manager.

After a user exceeds
the time out
value, the Active
Workspace viewer
tries to reconnect
but fails with
the following error:
Visualization
was not
loaded because
communication
was lost

The Visualization deployment was likely mistakenly configured with the
Teamcenter Load Balancer URL. Refer to Configure Visualization where
Teamcenter is deployed behind a load balancer.

In the developer tools console, the following error will appear if
the deployment was configured with the Load Balancer URL: Error:
Failed to connect to server: The TCLoginverifier likely
refused this visualization-specific request due a missing
connection to Teamcenter.
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Issue Possible resolution
The Viewer doesn't
load during
initialization and you
see a spinning circle.

There is a startup preference for Active Workspace that contains the list of
all preferences that are loaded at startup. It must contain the full list of
preferences required by the viewer. If some of the preferences are missing
from this preference or from the database, the viewer may not load properly.
You will see a spinning circle over the graphics area, but the viewer will not
load.

It is especially important to check this if Active Workspace preferences were
installed or upgraded without using the install scripts provided by Active
Workspace, or if they were modified after the install.

• All the viewer preferences must be in the database with valid values.

• Check the value of the AWC_startupPreferences preference. It should
contain the list of required viewer preferences.

The full preference list and their default values can be found at:

{ROOT}
\src\solutions\awv0activeworkspacevis\businessdata\awv0activeworkspacevis\i
nstall\awv0_preference_skip.xml

The full list is below.

AWC_visNavigationMode AWC_visStdViewOrientationFront
AWC_vis3DNavigationMode AWC_applyTrueShadingMaterial
AWC_visShading AWC_visOverlayDisplayEffectivity
AWC_visMaterial AWC_visSelectionDisplay
AWC_visTrihedronOn AWV0SectionCapsEdgesInitialState
AWC_visFloorOn AWV0HostAWInVisUponLaunch
AWC_visFloorPlaneOrientation AWV02DViewerRenderOption
AWC_visFloorOffset AWV0ViewerRenderOption
AWC_visGridOn AWC_visExamineZoomIn
AWC_visShadowOn AWC_visExposedBetaFeatures
AWC_visReflectionOn AWC_visAllOn
AWC_visStdViewOrientationTop AWC_3DViewerDisplayUnit
AWC_visStdViewOrientationLeft

The measurement or
PMI labels appear very
small on the screen.

You probably have a Visualization Server Manager deployed on Linux that
either does not have fonts installed, or the default DPI needs to be updated, or
both.

Solution

Troubleshooting Visualization
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Issue Possible resolution
1. Ensure that your Linux system has fonts installed. For details, see

Visualization Server Manager prerequisites for Linux.

2. Update the DPI. To do this, on your Linux system:

a. Modify the following values in the /etc/X11/xorg.conf file.

Earlier Modify to
DisplaySize: 508 317 DisplaySize: 224 128
SubSection "Display"
Virtual 1920 1200
Depth 24
EndSubSection

SubSection "Display"
Virtual 960 600
Depth 24
EndSubSection

b. Restart your Xserver.

c. Restart Visualization Server Manager.
Sessions saved in
standalone Lifecycle
Visualization are
not visible in the
Teamcenter rich client.

Ensure that your administrator has related the Vis Session dataset to the
specific item revision type which you plan to use for sessions.

1. In My Teamcenter, choose Edit→Options.

2. In the Options dialog box, choose General→Item Revision.

3. On the General tab, select the desired Item Revision type selected, for
example, Design Revision.

This specifies the item revision type for which the sessions saved in
standalone Lifecycle Visualization will be available in the Teamcenter rich
client.

4. If not already present in Shown Relations, under Available Relations,
select Vis Session, and add it to Shown Relations.
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Issue Possible resolution

5. Click Apply, and then click OK.

Record client issues in a log file

If an Active Workspace client connected to a Visualization Server has an issue, you can use the Logging
feature to record the issue in a log file to share with Siemens Digital Industries Software support who can
help you find a solution.

As an administrator, you can activate logging to collect debug information from the Active Workspace
Visualization Server. Once logging is activated, users can perform actions to replicate an issue and the
debug statements are captured in a log file.

Caution:

To avoid impacting performance to the Visualization Server, be sure to deactivate logging once
you have retrieved the necessary logs from the Visualization Server.

This method of capturing debug logs on the Visualization Server has the following benefits:

• Administrators can activate and deactivate logging on the Visualization Server from the web client
without the need to edit any configuration variables.

Record client issues in a log file
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• Logging can be activated and deactivated without shutting down or restarting the Visualization
Server, minimizing the impact to other users.

Procedure

1. In Active Workspace, on the global navigation toolbar on the home page, click Settings  and
choose Logging.

The Logging panel is displayed.

2. Select Visualization Logs as the Type of log you want to generate.

3. Click Start.

11. Monitoring and Troubleshooting Visualization
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The system begins recording the problem in a log file.

Note:

When logging is activated, logs are collected for all active Visualization users. Because
logging can create a lot of data, be careful not to leave logging activated when it is not
needed.

4. Click Stop to stop logs from being generated after the necessary log files have been collected from
the Visualization Server.

Troubleshooting an MMV deployment

This troubleshooting topic assumes that you have already deployed the Active Workspace 3D viewer,
Visualization Data Server (VDS), and indexed the structure with the MMV flag. If you do not have a
working Active Workspace 3D viewer, review the other topics within Monitoring and troubleshooting
Visualization. If you have a working viewer but your structure is not loading with MMV, then use this
checklist to troubleshoot your MMV deployment issues.

Use the following procedures to troubleshoot an Active Workspace MMV deployment.

Troubleshooting step Comments

Ensure the Active Workspace
Visualization Server Extension
feature is installed.

This feature adds the awv0activeworkspacevis_template.xml
template to the database.

Ensure that these licenses are
installed.

• Vis_simp_rendering
• Visualization Professional or Mockup service level

Ensure that FCC (File Client
Cache) is installed and configured
correctly.

The FCC should be large enough to load all the JT data that is
needed for the indexed products.

Use the VisView process log files
to determine if the viewer is using
the GPU.

1. Enable logging through the jettyservice.properties file.

2. Uncomment this line:

#VisPoolProxy.envset.TCVIS_LOGGING_LEVEL=DEB
UG

3. Restart the Visualization Server Manager.

4. Log into any log file for any VisView process.

Troubleshooting an MMV deployment
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Troubleshooting step Comments

The log output directory, which defaults to TEMP, should
look like the example below. The numbers will be different
but the pattern Visview*.log will remain the same.

5. Search for OpenGL to find a block of text that looks like the
example below.

If the version of OpenGL is greater than 1.1.0 ( 110 ), then
you are using the GPU.

Verify that the configuration that
is indexed is the same as what you
are trying to view, for example,
same revision, rule, effectivity, and
so on.

For more information on using the FTSIndexer, review
runTcFTSIndexer.

Use the following command to get the FTSIndexer status.

1. In the Teamcenter command prompt, enter the following
command:

runTcFTSIndexer –task=structure:show
2. Confirm that the State field value = 8 (success) and the

Subscribers field value = MMV.

Another way to verify that the indexing is successful is to:

1. Log in as the Teamcenter administrative user.
2. Locate the MMV Delta Collection - DO NOT DELETE folder.

11. Monitoring and Troubleshooting Visualization
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Troubleshooting step Comments

3. Inside the folder, locate the dataset with the
Awv0CompleteFile named reference, indicating successful
indexing.

If the structure is not MMV-indexed, review the bomindex_admin
to make sure it is configured correctly.

If the indexing did not succeed,
generate indexing logs for MMV.

1. Set the TcFtsIndexer logging to TRACE:

log4j.logger.com.siemens.teamcenter.ftsi=TRA
CE

2. Modify the existing %TcFtsIndexer.home%
\conf\TcFtsIndexer.properties parameter.

This keeps the generated MMP and TCXML files.
3. Cleanup the working directory and previously generated

logs.
4. Restart the TcFtsIndexer service.

Review the VDS console to verify
that there are no obvious error
messages.

1. Start up the VisDataServer.exe process.
2. Look for ***FULL STRUCTURE IMPORT COMPLETE output

for the BIADs (BOMIndexAdminData tables) that are MMV-
indexed.

You will not be able to view MMV until the import is
complete.

3. Review the console for any obvious error messages.

Troubleshooting an MMV deployment
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Troubleshooting step Comments

Correct an
InvalidCredentialsException
error on VDS startup.

VDS independently logs into Teamcenter using a password file
created by TEM or Deployment Center (DC). If this password is
wrong or lost, you will see an InvalidCredentialsException error in
the console on VDS startup. You can do the following to recreate
the file.

1. From the command line, enter the following commands:

Windows systems:

set TEM_SEENA=<password>
VisDataServer.exe /encryptpwf /
pwenv=TEM_SEENA /pwfile=d:\test.pwf
set TEM_SEENA=

Linux systems:

set TEM_SEENA=<password>
VisDataServer --encryptpwf 
--pwenv=TEM_SEENA --pwfile=/tmp/
test.pwf
set TEM_SEENA=

2. In the VisDataServer.properties file, ensure that these
values are correctly set:

• User name under which VDS accesses Teamcenter data
for the population of indexed models in its memory and
cache.

TeamcenterAccessManager.User1=Tc-admin-user
• Path to encrypted password file.

TeamcenterAccessManager.LoginFilePath1=C:/
myfolder/test.pwf
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Troubleshooting step Comments

Verify that the URL is configured
correctly and that the viewer can
access the VDS.

1. In the jetty.properties file for the viewer (not the VDS),
locate the line similar to the following example:

VisPoolProxy.envset.TCVIS_VISDATASERVERURL=h
ttp://<hostname>
:9990/ProductStructure

2. Copy and paste the URL into a browser window on the
machine where the viewer is running.

The VDS console should respond with an error message if
the URL is configured correctly and the viewer is accessing
the VDS.

If the VDS console does not respond, it means either that
this line in the jetty.properties file is misconfigured or that
something in the network is preventing the viewer from
contacting the VDS.

View the VDS logs if the viewer
isn't behaving as expected.

If the viewer isn't behaving as expected, do the following to view
the client communication logs to VDS. You should see a FindRoot
call to confirm that the viewer is attempting to load a structure
with the VDS.

1. Shut down VDS.
2. In the VDS.properties file, uncomment the following lines to

see the HTTP request from the client.

#logging.loggers.ProductStructure.name=Produ
ctStructure

#logging.loggers.ProductStructure.level=Debu
g

#logging.loggers.ProductStructure.channel=Co
nsoleChannel1

This will show client communication from the viewer to
VDS.

Note:

This will generate a lot of logs, so avoid doing this
until you have reached this step in the troubleshooting
process.

Troubleshooting an MMV deployment
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Troubleshooting step Comments

3. Locate the FindRoot call to confirm that the viewer is
attempting to load a structure with the VDS.

4. If there is no communication between the viewer and VDS
when a structure is loaded, turn on the SOADebug library
from the viewer:

• In the jetty.properties file, add the following line:

VisPoolProxy.envset.TC_SOACLIENT_LOGGING=D
EBUG

The soa_client log will be created in the TEMP directory.

• In the soa_client log, look for a GetStructureIDFromRecipe
call being made to Teamcenter from the viewer.
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A. Required RPM package managers
If you use the visualization server manager (VSM) on a Linux machine, make sure the following required
RPM package managers are available on the machine.

SUSE Linux:

fontconfig-2.11.1-7.1.x86_64
glibc-2.31-150300.46.1.x86_64
glibc-32bit-2.22-15.3.x86_64
libbz2-1-1.0.6-29.2.x86_64
libexpat1-2.1.0-21.3.1.x86_64
libexpat-devel-2.1.0-21.3.1.x86_64
libfreetype6-2.6.3-7.15.1.x86_64
libgcc_s1-8.2.1+r264010-1.3.3.x86_64
libGLU1-9.0.0-18.1.x86_64
libICE6-1.0.8-12.1.x86_64
libjpeg8-8.1.2-31.7.4.x86_64
libpng16-16-1.6.8-14.1.x86_64
libSM6-1.2.2-3.59.x86_64
libstdc++6-8.2.1+r264010-1.3.3.x86_64
libstdc++6-12.2.1+git416-150000.1.7.1.x86_64
libuuid1-2.29.2-7.14.x86_64
libX11-6-1.6.2-12.5.1.x86_64
libXau6-1.0.8-4.58.x86_64
libxcb1-1.10-4.3.1.x86_64
libXext6-1.3.2-4.3.1.x86_64
libXft2-2.3.1-9.32.x86_64
libXm4-2.3.4-4.15.x86_64
libXmu6-1.1.2-3.60.x86_64
libXp6-1.0.2-3.58.x86_64
libXrender1-0.9.8-7.1.x86_64
libXt6-1.1.4-3.59.x86_64
libz1-1.2.11-1.27.x86_64
Mesa-libGL1-18.0.2-6.28.x86_64

Note:

On SUSE Linux, the /usr/lib64/libGLdispatch.so.0 file is not owned by any package.

Also, the /usr/lib64/libGLX.so.0 file is not owned by any package.

RedHat Linux:

bzip2-libs-1.0.6-13.el7.x86_64
expat-2.1.0-10.el7_3.x86_64
expat-devel-2.1.0-10.el7_3.x86_64
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fontconfig-2.13.0-4.3.el7.x86_64
freetype-2.8-12.el7.x86_64
glibc-2.28-225.el8.x86_64
libgcc-4.8.5-36.el7.x86_64
libglvnd-1.0.1-0.8.git5baa1e5.el7.x86_64
libglvnd-glx-1.0.1-0.8.git5baa1e5.el7.x86_64
libICE-1.0.9-9.el7.x86_64
libjpeg-turbo-1.2.90-6.el7.x86_64
libpng-1.5.13-7.el7_2.x86_64
libSM-1.2.2-2.el7.x86_64
libstdc++-4.8.5-36.el7.x86_64
libstdc++-8.5.0-18.el8.x86_64
libuuid-2.23.2-59.el7.x86_64
libX11-1.6.5-2.el7.x86_64
libXau-1.0.8-2.1.el7.x86_64
libxcb-1.13-1.el7.x86_64
libXext-1.3.3-3.el7.x86_64
libXft-2.3.2-2.el7.x86_64
libXmu-1.1.2-2.el7.x86_64
libXp-1.0.2-2.1.el7.x86_64
libXrender-0.9.10-1.el7.x86_64
libXt-1.1.5-3.el7.x86_64
mesa-libGLU-9.0.0-4.el7.x86_64
motif-2.3.4-14.el7_5.x86_64
zlib-1.2.7-18.el7.x86_64
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